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Preface
Introduction

Cisco Desktop Administrator is a “container” program. This program allows you to 
access various other applications used to administer Cisco Agent Desktop and Cisco 
Supervisor Desktop from within one interface. 

NOTE:  Desktop Administrator is not supported if installed on a virtual 
private network (VPN) desktop.

What’s New In This Release

Version 6.4(1)

■ Support for Windows 2003 Server

■ CAD and IP Phone agents can now enter wrap-up data, and supervisors will 
see that wrap-up data as part of the Agent ACD State Log report

■ Cisco Unified CCX Outbound Preview Dialer (Outbound Dialer) is now available 
(Direct Preview Dialing Mode only)

Version 6.4(2)

■ Support for Microsoft Vista Business and Ultimate editions

■ Standard Bundle no longer includes Cisco Agent Desktop

■ New utility (the NIC Qualification Tool) that tests if a NIC is compatible with 
CAD desktop monitoring requirements
11
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Desktop Administrator Feature Levels

There are three versions of Cisco Desktop Administrator: Standard, Enhanced, and 
Premium. The following chart outlines the features available in each version. All 
features not listed here are present in all three versions.

Related Documentation

The following documents contain additional information about CAD 6.4:

■ Cisco CAD Installation Guide

■ Cisco Agent Desktop User Guide

■ Cisco Supervisor Desktop User Guide

■ Cisco IP Phone Agent User Guide

■ Cisco CAD Service Information

■ Integrating CAD Into a Citrix MetaFrame Presentation Server or Microsoft 
Terminal Services Environment

Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. Cisco also 
provides several ways to obtain technical assistance and other technical resources. 
These sections explain how to obtain technical information from Cisco Systems.

Cisco.com

You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

Feature Standard Enhanced Premium

Configure CAD interface × ×

Configure work flows × ×

Configure server and desktop monitoring × ×

Wrap-up data × ×

Cisco Unified CCX Outbound Preview Dialer × ×
12 December 2007
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You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD

The Product Documentation DVD is a comprehensive library of technical product 
documentation on a portable medium. The DVD enables you to access multiple 
versions of installation, configuration, and command guides for Cisco hardware and 
software products. With the DVD, you have access to the same HTML documentation 
that is found on the Cisco website without being connected to the Internet. Certain 
products also have PDF versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. 
Registered Cisco.com users (Cisco direct customers) can order a Product 
Documentation DVD (product number DOC-DOCDVD= or DOC-DOCDVD=SUB) from 
Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Ordering Documentation

Registered Cisco.com users may order Cisco documentation at the Product 
Documentation Store in the Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Nonregistered Cisco.com users can order technical documentation from 8:00 a.m. to 
5:00 p.m. (0800 to 1700) PDT by calling 1 866 463-3487 in the United States and 
Canada, or elsewhere by calling 011 408 519-5055. You can also order 
documentation by e-mail at tech-doc-store-mkpl@external.cisco.com or by fax at 
1 408 519-5001 in the United States and Canada, or elsewhere at 011 408 
519-5001.

Documentation Feedback

You can rate and provide feedback about Cisco technical documents by completing 
the online feedback form that appears with the technical documents on Cisco.com.

You can submit comments about Cisco documentation by using the response card (if 
present) behind the front cover of your document or by writing to the following 
address:

Cisco Systems 
Attn: Customer Document Ordering 
170 West Tasman Drive 
San Jose, CA 95134-9883
December 2007 13
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We appreciate your comments.

Product Alerts and Field Notices

Modifications to or updates about Cisco products are announced in Cisco Product 
Alerts and Cisco Field Notices. You can register to receive Cisco Product Alerts and 
Cisco Field Notices by using the Product Alert Tool on Cisco.com. This tool enables you 
to create a profile and choose those products for which you want to receive 
information. Access the tool at this URL:

http://tools.cisco.com/Support/PAT/do/ViewMyProfiles.do?local=en.

Cisco Product Security Overview

Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_
policy.html

From this site, you will find information about how to:

■ Report security vulnerabilities in Cisco products.

■ Obtain assistance with security incidents that involve Cisco products.

■ Register to receive security information from Cisco.

A current list of security advisories, security notices, and security responses for Cisco 
products is available at this URL:

http://www.cisco.com/go/psirt

To see security advisories, security notices, and security responses as they are 
updated in real time, you can subscribe to the Product Security Incident Response 
Team Really Simple Syndication (PSIRT RSS) feed. Information about how to 
subscribe to the PSIRT RSS feed is found at this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products

Cisco is committed to delivering secure products. We test our products internally 
before we release them, and we strive to correct all vulnerabilities quickly. If you think 
that you have identified a vulnerability in a Cisco product, contact PSIRT:

■ For Emergencies only — security-alert@cisco.com

An emergency is either a condition in which a system is under active attack or 
a condition for which a severe and urgent security vulnerability should be 
reported. All other conditions are considered nonemergencies.
14 December 2007
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■ For Nonemergencies — psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

■ 1 877 228-7302

■ 1 408 525-6532

NOTE:  We encourage you to use Pretty Good Privacy (PGP) or a 
compatible product (for example, GnuPG) to encrypt any sensitive 
information that you send to Cisco. PSIRT can work with information 
that has been encrypted with PGP versions 2.x through 9.x.  
 
Never use a revoked or an expired encryption key. The correct public 
key to use in your correspondence with PSIRT is the one linked in the 
Contact Summary section of the Security Vulnerability Policy page at 
this URL: 
 
http://www.cisco.com/en/US/products/products_security_
vulnerability_policy.html 
 
The link on this page has the current PGP key ID in use. 
 
If you do not have or use PGP, contact PSIRT at the aforementioned 
e-mail addresses or phone numbers before sending any sensitive 
material to find other means of encrypting the data.

Obtaining Technical Assistance

Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. 
The Cisco Technical Support & Documentation website on Cisco.com features 
extensive online support resources. In addition, if you have a valid Cisco service 
contract, Cisco Technical Assistance Center (TAC) engineers provide telephone 
support. If you do not have a valid Cisco service contract, contact your reseller.

Cisco Technical Support & Documentation Website

The Cisco Technical Support & Documentation website provides online documents 
and tools for troubleshooting and resolving technical issues with Cisco products and 
technologies. The website is available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website requires 
a Cisco.com user ID and password. If you have a valid service contract but do not have 
a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do
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NOTE:  Use the Cisco Product Identification (CPI) tool to locate your 
product serial number before submitting a web or phone request for 
service. You can access the CPI tool from the Cisco Technical Support 
& Documentation website by clicking the Tools & Resources link 
under Documentation & Tools. Choose Cisco Product Identification 
Tool from the Alphabetical Index drop-down list, or click the Cisco 
Product Identification Tool link under Alerts & RMAs. The CPI tool 
offers three search options: by product ID or model name; by tree 
view; or for certain products, by copying and pasting show command 
output. Search results show an illustration of your product with the 
serial number label location highlighted. Locate the serial number 
label on your product and record the information before placing a 
service call.

Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and S4 
service requests. (S3 and S4 service requests are those in which your network is 
minimally impaired or for which you require product information.) After you describe 
your situation, the TAC Service Request Tool provides recommended solutions. If your 
issue is not resolved using the recommended resources, your service request is 
assigned to a Cisco engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests, or if you do not have Internet access, contact the Cisco 
TAC by telephone. (S1 or S2 service requests are those in which your production 
network is down or severely degraded.) Cisco engineers are assigned immediately to 
S1 and S2 service requests to help keep your business operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227) 
EMEA: +32 2 704 55 55 
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has 
established severity definitions.

Severity 1 (S1)—An existing network is down, or there is a critical impact to your 
business operations. You and Cisco will commit all necessary resources around the 
clock to resolve the situation. 
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Severity 2 (S2)—Operation of an existing network is severely degraded, or significant 
aspects of your business operations are negatively affected by inadequate 
performance of Cisco products. You and Cisco will commit full-time resources during 
normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of the network is impaired, while most 
business operations remain functional. You and Cisco will commit resources during 
normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, 
installation, or configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is available 
from various online and printed sources.

■ The Cisco Product Quick Reference Guide is a handy, compact reference tool 
that includes brief product overviews, key features, sample part numbers, 
and abbreviated technical specifications for many Cisco products that are 
sold through channel partners. It is updated twice a year and includes the 
latest Cisco offerings. To order and find out more about the Cisco Product 
Quick Reference Guide, go to this URL: 

http://www.cisco.com/go/guide

■ Cisco Marketplace provides a variety of Cisco books, reference guides, 
documentation, and logo merchandise. Visit Cisco Marketplace, the company 
store, at this URL:

http://www.cisco.com/go/marketplace/

■ Cisco Press publishes a wide range of general networking, training and 
certification titles. Both new and experienced users will benefit from these 
publications. For current Cisco Press titles and other information, go to Cisco 
Press at this URL:

http://www.ciscopress.com

■ Packet magazine is the Cisco Systems technical user magazine for 
maximizing Internet and networking investments. Each quarter, Packet 
delivers coverage of the latest industry trends, technology breakthroughs, and 
Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, 
certification and training information, and links to scores of in-depth online 
resources. You can access Packet magazine at this URL:

http://www.cisco.com/packet
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■ iQ Magazine is the quarterly publication from Cisco Systems designed to help 
growing companies learn how they can use technology to increase revenue, 
streamline their business, and expand services. The publication identifies the 
challenges facing these companies and the technologies to help solve them, 
using real-world case studies and business strategies to help readers make 
sound technology investment decisions. You can access iQ Magazine at this 
URL:

http://www.cisco.com/go/iqmagazine

or view the digital edition at this URL:

http://ciscoiq.texterity.com/ciscoiq/sample/

■ Internet Protocol Journal is a quarterly journal published by Cisco Systems for 
engineering professionals involved in designing, developing, and operating 
public and private internets and intranets. You can access the Internet 
Protocol Journal at this URL:

http://www.cisco.com/ipj

■ Networking products offered by Cisco Systems, as well as customer support 
services, can be obtained at this URL:

http://www.cisco.com/en/US/products/index.html

■ Networking Professionals Connection is an interactive website for networking 
professionals to share questions, suggestions, and information about 
networking products and technologies with Cisco experts and other 
networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

■ World-class networking training is available from Cisco. You can view current 
offerings at this URL:

http://www.cisco.com/en/US/learning/index.html
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About This Document
About This Document

Intended Audience

This document is written for contact center system administrators who use Desktop 
Administrator.

Conventions Used

This document uses the following conventions:

Convention Use

Bold Highlights keys, buttons, and menu items you can 
select in the interface.

Code Highlights file paths and code.

Italic Highlights book titles, variables, and terms that are 
defined.

> The angle bracket indicates a menu choice. For 
example, “choose File > Open” means “click the File 
menu, and then click Open.”
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Getting Started
Starting Desktop Administrator

Desktop Administrator comes with one license for each node in the navigation tree. 
There can be only one user at a time working in each node. If someone is using a node 
that you must access, an error message appears that identifies the IP address of the 
computer accessing that particular node.

NOTE:  If the LRM service is down the error message will only tell you 
that another user is using the node. The IP address will not be 
available. 

For this reason, it is important that you close Desktop Administrator completely when 
you are done using it. As long as the application is running, a license is being used and 
others are blocked from accessing the node selected in your instance of the 
application.

To start Desktop Administrator:

■ Click Start > Programs > Cisco > Desktop > Admin. 

Desktop Administrator starts.

NOTE:  In a redundant system configuration, if the primary CRS server 
fails, the instance of Desktop Administrator on the secondary CRS 
server will start in the normal amount of time. However, if the primary 
CRS server is removed from the network, the secondary Desktop 
Administrator may take up to 5 minutes to start completely. Each of 
the modules that make up Desktop Administrator attempts to contact 
the primary Directory Services on the disconnected server. Only when 
each module has discovered the server is no longer on the network 
and has connected to the secondary Directory Services will Desktop 
Administrator start.
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Automated Updates

Every time you start Desktop Administrator, the application checks to see if there is an 
updated version available, or if there was a system configuration change that requires 
a Windows registry change. If either condition exists, the application automatically 
runs the update process.

NOTE:  For automated updates to function correctly, Internet Explorer 
must be configured so that it checks for newer versions of stored 
pages. In Internet Explorer, choose Tools > Internet Options and 
select the General tab. In the Temporary Internet Files section, click 
Settings and ensure that any option other than Never is selected.

NOTE:  If your system is configured with two CRS servers, and one 
server is upgraded while your instance of Desktop Administrator is 
connected to the older CRS, and your system administrator performs 
a failover to switch all agents to the upgraded server, your instance of 
Desktop Administrator will not automatically upgrade when you log 
into the new server. You must shut down Desktop Administrator and 
start it again for the automatic upgrade to take place.

Automated Updates in CAD 6.4(1)

When an update is available, you will see a dialog box notifying you that your copy of 
Desktop Administrator will be updated. Click OK to proceed with the update.

When the update is finished, you will see a final dialog box telling you that your update 
is complete. After you click OK to clear that dialog box, restart Desktop Administrator.

Automated Updates in CAD 6.4(2)

When an update is available, you will see a dialog box notifying you that your copy of 
Desktop Administrator will be updated. Click OK to proceed with the update.

A progress bar is displayed to show you the status of the download.

When the update is finished, you will see a final dialog box that tells you the update is 
complete, and which applications were updated. If you have other CAD applications 
(Cisco Agent Desktop and Cisco Supervisor Desktop) on your PC, they will all have 
been updated.

NOTE:  Because Agent Desktop is automatically installed when 
Supervisor Desktop is installed, only Supervisor Desktop will be listed 
as having been updated in the final dialog box. Agent Desktop will be 
listed only if Supervisor Desktop is not present on your PC.
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When you click OK to close the dialog box, any CAD application that had been running 
on your desktop restarts automatically.
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The Desktop Administrator Interface

The Desktop Administrator interface has two panes. The left pane is a navigation tree 
similar to that found in Windows Explorer. The right pane displays the application that 
you choose in the left pane. 

Figure 1. The Desktop Administrator interface. In this example, the Dial Strings node is 
selected in the left pane and displayed in the right pane.

The root of the navigation tree is Locations. Underneath Locations is the logical 
contact center set up in your system. Underneath the logical contact center is a list of 
the applications that administer Agent Desktop, Supervisor Desktop, and IP Phone 
Agent.

Toolbars and Menu Bars

When you select a node on the navigation tree, the Desktop Administrator menu bar 
and toolbar change to reflect the design of that node’s application. 

The toolbar buttons you see are among those listed in Table 1. 

Table 1. Desktop Administrator toolbar buttons.

Button Name Description

About Displays copyright and version information
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Navigation Tree Pane

Use these mouse or keyboard actions in the left pane to navigate the tree.

Mouse

■ Double-click an icon/application name to expand or collapse the tree.

■ Click the plus sign ( + ) to expand the tree.

■ Click the minus sign ( – ) to collapse the tree.

■ Right-click to rename or delete a node (not available for all nodes).

Keyboard
With a node selected,

■ Press the up and down arrow keys to move from one node to the next.

■ Press the left arrow key to collapse the tree.

■ Press the right arrow key to expand the tree.

■ Press F2 to rename an icon (not available for all nodes).

Display Pane Navigation

The applications displayed in the right pane are designed to use shortcut keys and the 
tab key as alternatives to using the mouse to navigate around a window. The shortcut 
keys that apply to a specific node are discussed in the section devoted to that node’s 
functions.

Delete Removes the selected work flow group

Remove VoIP, 
Record/Playback 
Services

Removes unneeded services from LDAP.

Help Accesses Help files

New Adds a new work flow group 

Web Opens your web browser and accesses 
Cisco’s website

Table 1. Desktop Administrator toolbar buttons.

Button Name Description
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User Privileges in Windows 2000 and 
Windows XP

Because Desktop Administrator users must be able to update registry settings, they 
must have Administrator or Power User privileges on Windows 2000 and Windows XP 
platforms. 

Only a person with Administrator privileges can change user privileges on the 
Administrator PC if it is necessary to upgrade them.
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Passwords

Desktop Administrator

A password is optional for Desktop Administrator. If a password is configured, when 
you select the logical contact center node you will be prompted to provide the 
password before you can access any of the subnodes. 

To set up a password:

1. In the navigation pane, select the Call Center 1 node.

2. From the menu bar, choose Setup > Change Password.

The Administrator Password dialog box appears (see Figure 2).

Figure 2. Administrator Password dialog box.

3. Leave the Old Password field blank, and enter a new password, type it again 
to confirm it, and then click OK.

Passwords are case sensitive and can consist of up to a maximum of 32 
alphanumeric characters.

Desktop Administrator is now password protected. You must restart the 
application for the change to go into effect.

To change your password:

1. In the left pane, select the Call Center 1 node

2. From the menu bar, choose Setup > Change Password.

The Change Password dialog box appears (see Figure 2).

3. Enter your old password, a new password, and your new password again to 
confirm it, and then click OK.

Your Desktop Administrator password is now changed. You must restart the 
application for the change to go into effect.

NOTE: If you are setting up 
a new password, the Old 
Password field is disabled.
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To remove password protection:

1. In the left pane, select the Call Center 1 node

2. From the menu bar, choose Setup > Change Password.

The Change Password dialog box appears (see Figure 2).

3. Enter your old password, leave the New password and Confirm password 
fields blank, and then click OK.

4. You are asked to confirm that you want to leave Desktop Administrator 
unprotected. Click Yes.

The Desktop Administrator password has been removed. You must restart the 
application for the change to go into effect.

Agent Desktop User IDs and Passwords

Agent Desktop user IDs and passwords are set up in CallManager  and can be 
administered only through CallManager. The user’s Agent Desktop password is 
verified on the CTI server when a user starts the application.

Use CallManager to change a user’s Agent Desktop password if it becomes necessary 
to do so.

Supervisor Desktop User IDs and Passwords

A user’s Supervisor Desktop user ID and password are the same as the user’s Agent 
Desktop user ID (the user ID, as set up in CallManager, is used as both the user ID 
and password). User IDs and passwords are verified in Directory Services when the 
user starts Supervisor Desktop.

You can change a Supervisor Desktop password via the Supervisors subnode under 
the Personnel Configuration. It can also be changed from within Supervisor Desktop.

NOTE:  If the supervisor’s agent record in CallManager is changed, 
the supervisor’s user ID and password are reset to the default (the 
agent user ID is used for both the supervisor user ID and password). 
The supervisor will be unable to log in using his or her previous 
password. The supervisor should use the default password to log in, 
after which he or she can use the Change Password function in Cisco 
Supervisor Desktop to change the password to something more 
secure. 
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CAD Configuration Setup Utility

You can use the CAD Configuration Setup utility to configure the CAD services.

CAD Configuration Setup runs initially as part of the CAD installation process. After 
initial installation, you can change your configuration settings by launching it from 
Desktop Administrator or running PostInstall.exe (located in the …\Program 
Files\Cisco\Desktop\bin folder on each CAD computer). 

CAD Configuration Setup displays different step windows, depending on which host 
computer it runs on. Table 2 shows which step windows appear when CAD 
Configuration Setup is run on a specific host computer. Refer to this table to 
determine where you should run Configuration Setup to change the desired 
configuration setting.

NOTE:  If you run CAD Configuration Setup on a computer that hosts 
only Desktop Administrator, and no other CAD application or service, 
you will receive a message that there is nothing to configure on that 
computer. Run CAD Configuration Setup on another computer that 
hosts CAD services or applications.  

To modify configuration data:

1. Start CAD Configuration Setup.

■ In Desktop Administrator, select the Call Center 1 node in the left pane 
and then choose Setup > Configure Systems from the menu bar.

■ On another CAD host computer, navigate to the …\Program 
Files\Cisco\Desktop\bin folder and double-click PostInstall.exe.

Configuration Setup starts and displays the CAD Directory Services dialog box.

Table 2. CAD Configuration Setup windows displayed per host computer

Step Name Base*

* Header key: Base—Base services; VoIP—VoIP Monitor service: Rec—Recording service: CAD CSD—
Cisco Agent Desktop, Cisco Supervisor Desktop—CDA: Cisco Desktop Administrator

VoIP Rec
CAD 
CSD CDA

VoIP Network Device Step (page 31) × × ×

Services IP Address Step (page 32) × × ×

Terminal Services Step (page 33) ×
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Figure 3. Cisco Agent Desktop Directory Services dialog box.

2. Ensure that the correct primary (and optional secondary) Directory Services IP 
addresses are entered, and then click OK.

The Cisco Agent Desktop Configuration Setup utility is displayed, with the 
CallManager node selected.

NOTE:  You can press F6 to switch between the left and right pane, 
and the up and down arrows to move up and down the navigation 
tree in the left pane.

3. Select the step window you want to modify from the left pane, enter the new 
data in the right pane, and then click Apply.

■ You can display the step windows in any order you wish.

■ If you modify something in a step window, you must click Apply to save 
your changes before you move on to another window.

4. When you are done making your changes, choose File > Exit from the menu or 
click Close.

CAD Configuration Setup closes.

5. Stop and restart the modified service and all desktops for the change to go 
into effect.
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Configuration Setup Step Windows

VoIP Network Device Step

Figure 4. VoIP Network Device step.

Select the IP address of the network adaptor to which voice packets are sent to be 
sniffed by the VoIP Monitor service (if this is a server box) or the desktop monitor (if 
this is a client desktop).

■ On a VoIP Monitor Service server, it is the IP address of the NIC that is 
connected to the port configured for SPAN.

■ On a client desktop computer, it is the IP address of the NIC on which the 
computer is daisy-chained to the phone.

NOTE:  If you change these settings after initial setup, you must 
restart the VoIP Monitor service or the client application (depending 
on where you run CAD Configuration Setup) to ensure that the change 
is registered with them properly.
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Services IP Address Step

Figure 5. Services IP Address step.

If the computer has more than one IP address, select the IP address of the NIC used 
to connect to the LAN—it must be accessible by the client desktops.

In order to connect to the CallManager, the IPPA service must have a user ID and 
password. This user ID and password are also set up in CallManager (see “Configuring 
Cisco CallManager IP Phones to Work With IP Phone Agent” in the Cisco CAD 
Installation Guide). You can complete these fields before actually setting up the user 
in CallManager, but the user ID and password must be identical in both places. If they 
are changed in this window or in CallManager, they must be changed in both.

NOTE:  If Directory Services is not running when you view this step, 
the IPPA login information cannot be changed.

NOTE:  If you change these settings, you must restart all CAD services 
to ensure that the change is registered with them properly.
32 December 2007



CAD Configuration Setup Utility
Terminal Services Step

Figure 6. Terminal Services step.

If this installation of Cisco Agent Desktop is installed in a Microsoft Terminal Services 
or Citrix environment, click Yes. If not, click No.
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Synchronizing Directory Services

The Directory Services database should be synchronized with the master CRS agent 
database. The databases are synced automatically whenever the master CRS 
database changes. However, you can manually sync them with the Synchronize 
Directory Services command.

To synchronize the databases manually:

1. In the left pane, select the Call Center 1 node.

2. From the menu, choose Setup > Synchronize Directory Services.

When the synchronization is complete, the system displays a confirmation 
message that Directory Services was successfully synchronized.
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Enterprise Data Configuration
Introduction

Enterprise Data Configuration enables you to:

■ Set up enterprise data layouts and fields

■ Assign phones to be monitored by a particular Voice-Over IP Monitor service

■ Remove deleted VoIP Monitor and Recording & Playback services from 
Directory Services

To use either Enterprise Data Configuration application, select the Enterprise Data 
node or VoIP Monitor node in the left navigation pane of the Desktop Administrator 
window.
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Enterprise Data

Enterprise data is information associated with an incoming call. It is displayed in Cisco 
Agent Desktop and the Cisco IP Phone Agent service (see Figure 7).

Figure 7. Enterprise data as it appears in Cisco Agent Desktop (top) and Cisco IP Phone Agent 
(bottom). Both applications use the same default layout.

Use Desktop Administrator’s Enterprise Data window to specify what information is 
displayed and how it appears in the agent applications. 

NOTE:  The agent applications must be restarted for any enterprise 
data variable or layout changes you make to go into effect.

When you select Enterprise Data in the navigation pane, the display pane displays the 
Field List and Layout List (see Figure 8).

14:23 02/15/07 2101

Caller Data - ID:2311
Layout: Default

Talking

DNIS: 2101

Stats

ANI: 2501

Option
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Figure 8. The Enterprise Data window.

Fields

The Field List displays both the predefined fields available for your switch type and the 
custom fields you create using the Field Editor.

■ Predefined fields have index numbers of 200–255. Only the display name of 
these fields is editable, with the exception of field 252, whose display name 
and field name can be edited.

■ Custom fields have index numbers of 0–199, and are editable.

To add a custom field to the Field List:

1. In the Field List area, click Add.

The Field Editor dialog box appears (see Figure 9).
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Figure 9. The Field Editor dialog box.

2. Choose a field index number from the drop-down list. 

The field automatically shows the next available number.

3. Enter a field name that describes the contents of the field. 

The field name and value can contain only the following characters. 

■ Alphanumeric characters (Aa–Zz, 0–9)

■ Underscore ( _ )

■ Period ( . )

If you use disallowed characters in the field name or value, the enterprise 
data field may not display in the IP Phone Agent service.

NOTE:  For Chinese and Korean localized sites, IP Phone Agent 
phones display the field index number, not the field name. This is due 
to phone limitations on displaying multi-byte characters. 

4. Enter a display name. This is what is displayed in the desktop application.

5. If the field is an ECC variable, select the appropriate check box:

■ Scalar: A scalar ECC variable is one that stores a single piece of data.

■ Array: An array ECC variable is one that stores multiple pieces of data.

6. If you selected array, specify the number of elements in the array in the 
number field. 

Entering a number in the number field disables the Field Index field. The 
system automatically assigns the next available indexes to each element in 
the array. 

7. Click OK.

The Field Editor dialog box closes.
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8. In the Enterprise Data window, click Apply to save your changes.

New fields you create will not appear in lists of enterprise data fields until 
Desktop Administrator is restarted.

To edit an existing custom field:

1. In the field list, select the field you want to edit, and then click Edit.

The Field Editor dialog box appears.

2. Make your changes, and then click OK.

The Field Editor dialog box closes.

3. In the Enterprise Data window, click Apply to save your changes.

To delete a custom field:

1. In the field list, select the field you want to delete, and then click Delete.

You can delete only custom fields.

2. In the Enterprise Data window, click Apply to save your changes.

Layouts

The Layout List displays the field layouts available for use in the agent application. 
Each layout can contain up to 16 fields chosen from the fields in the Field List.

There are two default layouts: default and OODefault. CRS automatically uses the 
default layout for normal call activity, and the OODefault layout whenever an agent 
receives an Outbound Dialer call. The OODefault layout contains all of the Outbound 
Dialer enterprise data variables.

You cannot delete either of the default layouts, but they can be edited to add or 
remove enterprise data variables.

You can create up to 14 custom layouts in addition to the 2 default layouts.

To edit an existing default or custom layout:

1. In the Layout List, select the layout you want to edit, and then click Edit.

The Layout Editor dialog box appears.

2. Make your changes, and then click OK.

The Layout Editor dialog box closes.

3. In the Enterprise Data window, click Apply to save your changes.
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To delete an existing custom layout:

1. In the Layout List, select the layout you want to delete.

2. Click Delete.

The layout is deleted.

3. In the Enterprise Data window, click Apply to save your changes.

Custom Layouts

If you want to use a custom layout rather than the default layout, you must first create 
the custom layout, and then create a custom Cisco Unified CCX script.

To use custom layout:

1. Create a new layout (see “To create a custom layout” below).

2. Write a Cisco Unified CCX script that contains the Set Enterprise Call Info Step, 
and reference the new layout name in the script.

See the Cisco CRS Editor Step Reference Guide for information on creating 
Cisco Unified CCX scripts and steps.

3. Under the Expanded Call Variables tab of the Set Enterprise Call Info step, the 
Name should be “user.layout” (include the double quotes), and the Value 
should be the name of the layout you created in Step 1.

To create a custom layout:

1. In the Layout List area, click Add.

The Layout Editor dialog box appears (see Figure 10).

2. In the Layout Name field, enter a name for your custom layout. 

3. Select the desired field from the available fields in the right pane, and either 
click the left arrow button or double-click your selection to move it to the left 
pane. You can select up to 16 fields.

NOTE:  There are 10 custom ECC variables named “Call Variable 1” 
through “Call Variable 10”. These custom variables are written into 
CCDRs (call control data records) after the call ends. If an agent edits 
the value during a call, the edited value is recorded in the database. 
These variables are the only ones that can be looked up or accessed 
after a call has ended—other ECC variables are lost. 

4. To rearrange the order in which fields are displayed in the left pane, select a 
field and click the up or down arrow button to move the field up or down in the 
list.

5. When the layout is arranged to your satisfaction, click OK.
40 December 2007



Enterprise Data
The Layout Editor dialog box closes.

6. In the Enterprise Data window, click Apply to save your changes.

Figure 10. The Layout Editor dialog box.
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VoIP Monitor

The VoIP Monitor window (Figure 11) enables you to:

■ Set a default VoIP Monitor server

■ Configure devices to be monitored by specific VoIP Monitor servers

■ Enable desktop monitoring

Figure 11. The VoIP Monitor window.

Desktop Monitoring

Desktop monitoring is used to monitor phones used with Agent Desktop. 

With desktop monitoring enabled, software on the agent desktop handles recording 
and monitoring requests for that agent. This is possible only on desktops that are 
physically connected to the network through a hard IP phone or through a soft phone. 

NOTE:  Desktop monitoring does not function with some NIC cards 
that are unable to detect both voice packets and data packets in a 
multiple VLAN environment. For more information on this issue, and 
suggested work-arounds, see the Cisco CAD Installation Guide.
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A phone is monitored either through desktop monitoring or a VoIP Monitor service—it 
cannot be monitored by both. Desktop monitoring is enabled by default.

To enable desktop monitoring:

■ Select the device’s Enable Desktop Monitoring check box.

VoIP Monitor Service Monitoring

VoIP Monitor Service monitoring can be used to monitor phones used with Agent 
Desktop and with IP Phone Agent. 

If your system has only one VoIP Monitor service, it is not necessary to set a default 
monitor service or to manually assign each device to that single monitor. The VoIP 
Monitor service assumes that each device is assigned to it as the only available 
monitor service.

If your system has more than one VoIP Monitor service, it is advisable to select a 
default monitor service to avoid the possibility of having devices unassigned to any 
monitor service.

Modifications you make in the VoIP Monitor window go into effect immediately after 
you leave the VoIP Monitor window.

Devices Displayed in the VoIP Monitor Window
The VoIP Monitor window displays all Unified CCX devices set up in the CallManager.

If a phone is configured for extension mobility, the Extension field displays the static 
extension assigned to the device’s MAC address (if one is set up). If no static 
extension is set up, the Extension field is blank.

NOTE:  Assign a static extension to an extension mobility device to 
make administration easier.

To set a default VoIP Monitor service:

■ From the Default VoIP Monitor Server field, choose a VoIP Monitor service. 

The service you choose is set as the default monitor service for your system. 
Any device not assigned to a specific VoIP Monitor service or that has desktop 
monitoring enabled is monitored by the default monitor service.

To assign a device to a specific VoIP Monitor service:

1. Using either the device’s extension or the MAC address, locate the device you 
wish to assign to a specific VoIP Monitor service. 

You can click on a column header to sort the column in ascending or 
descending order to make your search easier.
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2. Choose a VoIP Monitor service from the Monitor Server dropdown list. 

You can right-click anywhere in a device’s row to pop up the Select a VoIP 
Monitor Server dialog box from which to choose a VoIP Monitor service.

3. Make sure that the device’s Enable Desktop Monitoring check box is cleared.

The device is now assigned to that VoIP Monitor service.

To assign multiple devices to a specific VoIP Monitor service:

1. Use standard Windows multiple selection techniques to assign more than one 
device to a specific VoIP Monitor service:

■ Shift-Click to select a range of contiguous devices, then right-click the 
selected devices to display the Select a VoIP Monitor Server dialog box.

■ Ctrl-Click to select non-contiguous devices, then right-click the selected 
devices to display the Select a VoIP Monitor Server dialog box.

2. Choose the VoIP Monitor service from the dropdown list, and then click OK.

The devices you selected are now assigned to that VoIP Monitor service.

Effect of Combinations of Monitoring on Devices

Use Table 3 to determine the effect on monitored devices with various combinations 
of desktop monitoring, VoIP Monitor service monitoring, and setting a default monitor.

Table 3. Effect of Monitoring Options on Devices 

Desktop Mon. 
Selected

Specific VoIP 
Selected

Default VoIP 
Selected Effect on Devices

No No No

CAD/IPPA monitoring fails if there 
are multiple VoIP monitor 
services; monitored by default 
VoIP Monitor service if there is 
one VoIP Monitor service in the 
system.

No Yes No
CAD/IPPA monitored by specific 
VoIP Monitor service.

Yes Yes No
CAD monitored by Desktop 
Monitor; IPPA monitored by 
specific VoIP Monitor service.

No Yes Yes
CAD/IPPA monitored by specific 
VoIP Monitor service.
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Removing a VoIP Monitor or Recording & Playback 
Service

The Remove VoIP, Recording/Playback Server button on the toolbar enables you to 
remove a VoIP Monitor service or Recording & Playback service from Directory 
Services and unregister it from the LRM service.

Remove these services only if you intend to uninstall (or already have uninstalled) the 
VoIP Monitor service or Recording & Playback service permanently. The Remove 
option enables you to clean up Directory Services.

NOTE:  Removing a VoIP Monitor service can result in devices 
becoming unmonitored.

To remove a VoIP Monitor or Recording & Playback service from  
Directory Services:

1. Click the Remove VoIP, Recording/Playback Server button on the toolbar.

The Remove VoIP/Recording & Playback Server dialog box is displayed (Figure 
12). 

Yes No No

CAD monitored by Desktop 
Monitor. If there is only one VoIP 
Monitor service in the system, it 
monitors IPPA.

Yes No Yes
CAD monitored by Desktop 
Monitor. IPPA monitored by 
default VoIP Monitor service.

No No Yes
CAD/IPPA monitored by default 
VoIP Monitor service.

Yes Yes Yes
CAD monitored by Desktop 
Monitor; IPPA monitored by 
specific VoIP Monitor service.

Table 3. Effect of Monitoring Options on Devices — Continued

Desktop Mon. 
Selected

Specific VoIP 
Selected

Default VoIP 
Selected Effect on Devices
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Figure 12. The Remove VoIP/Recording & Playback Server dialog box.

2. From the appropriate dropdown list, select the service you want to remove 
from Directory Services. 

3. Click Remove. 

The selected service is removed from Directory Services and unregistered 
from the LRM service.

4. Click Close to close the dialog box.

To restore a removed service to Directory Services:

1. Stop and then restart the removed service from the Windows Services dialog 
box.

2. Click any other node on the navigation tree and then click the VoIP Monitor 
subnode again.

The refreshed window shows that the service is restored to the list of available 
services.
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Desktop Configuration
Introduction

NOTE:  For Version 6.4(2) Users: If you have the Standard bundle, the 
only functionality available to you under the Desktop Configuration 
node is Reason Codes. The Enhanced and Premium bundles include 
all the functionality described in this chapter.

Desktop Configuration enables you to configure and maintain the appearance and 
behavior of Agent Desktop. Desktop Configuration has the following functions:

■ Dial Strings (page 49)

■ Phone Book (page 62)

■ Reason Codes (page 65)

■ Monitor/Record Notification (page 68)

■ Work Flow Groups (page 69)

To use any Desktop Configuration application, select its node in the left Navigation 
pane of the Desktop Administrator window (see Figure 13) . The right Display pane 
shows the selected application.

Agent Desktop must be restarted for any configuration changes you make to go into 
effect.

NOTE:  When configuring the name or ID of objects (examples are 
work groups, work flows, agent login names, server names, and 
macro names), do not use the “=”character. This can cause problems 
when backing up and restoring data.
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Figure 13. The Desktop Configuration window.
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Dial Strings

Use the Dial Strings option to configure the way Agent Desktop displays and dials 
phone numbers.

Select the appropriate check box at the bottom of the Dial Strings pane to choose the 
dial string format you will use. The available formats are: 

■ North American Dial String format. This format (also known as the North 
American Numbering Plan, or NANP) consists of a 3-digit area code, a 3-digit 
exchange, and a 4-digit subscriber number. 

■ Variable Format Dial String format. This format allows for the wide variability 
of non-North American phone numbers that do not adhere to the North 
American Numbering Plan.

Different tabs display depending on your choice. Only one dial string format can be 
enabled at any one time, although both formats can be configured. 

North American Dial String Format

If you choose the North American dial string format, the following three tabs are 
active:

■ Telephone Number Display Tab (page 49)

■ Outgoing Calls Tab (page 50)

■ Miscellaneous Tab (page 54)

Telephone Number Display Tab

The Telephone Number Display tab (Figure 14) enables you to configure how phone 
numbers are displayed in Agent Desktop. 

The selections you make are reflected in the Sample fields. (An exception is if you 
enter a value in either of the “Remove first ‘n’ digits” and “Remove last ‘n’ digits” 
fields. In that case, the sample does not change.)
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Figure 14. Telephone Number Display tab.

To configure the telephone number display:

■ Select or clear the check boxes and radio buttons on the Telephone Number 
Display tab as desired, and then click Apply to save your changes.

Outgoing Calls Tab

The Outgoing Calls tab (Figure 15) enables you to configure your local area codes and 
exchanges.

Table 4. Telephone Number Display tab fields 

Tab Section Description

External number format Specify the calling and called phone numbers format

Area code/Exchange Specify the separator between the area code and 
exchange

Exchange/Subscriber 
code

Specify the separator between the exchange and the 
subscriber code

Internal number format Specify the internal phone numbers format. You can 
include an X (extension) and remove the leading or 
trailing digits (in the event that extension numbers are 
less than 4 digits long). 
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Figure 15. Outgoing Calls tab.

Table 5. Outgoing Calls tab fields  

Tab Section Description

Local area code Enter the local 3-digit area code.

Advanced Dialing… Click to configure advanced internal and external dialing 
(see page 52).

Prefixes • Local line access code. Enter the number required to 
access an outside local line

• Long distance line access code. The number 
required to access an outside long distance line

• Ensure a 1 on long distance calls. Check to 
automatically add a 1 at the beginning of a long 
distance phone number

• Use area code for toll calls within the area code. 
Check to automatically add the local area code to 
any calls dialed to numbers not included in the local 
exchange list.

• Use area code for local calls. Check to automatically 
add the local area code to any calls dialed to 
numbers included in the local exchange list.
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To configure outgoing calls:

■ Enter information and select or clear the appropriate check boxes on the 
Outgoing Calls tab as desired, and then click Apply to save your changes.

Advanced Internal Dialing Tab

The Advanced Internal Dialing tab (Figure 16) enables you to configure more internal 
dialing options. Access it by clicking the Advanced Dialing button on the Outgoing Calls 
tab.

Figure 16. Advanced Internal Dialing tab.

Local exchanges Check All exchanges are local or click Add to build a list 
of exchanges for which it is NOT necessary to add a 1 
before dialing

Table 5. Outgoing Calls tab fields — Continued — Continued

Tab Section Description
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Advanced External Dialing Tab

The Advanced External Dialing tab (Figure 17) enables you to configure more external 
dialing options. Access it by clicking the Advanced Dialing button on the Outgoing Calls 
tab.

Figure 17. Advanced External Dialing tab.

Table 6. Advanced Internal Dialing tab fields 

Tab Section Description

Extensions The maximum number of digits in an internal extension 
number, from 1–9. If you select 7, you must specify the 
internal exchange and the corresponding range of 
subscriber numbers so the application can distinguish 
between a 7-digit internal phone number and a 7-digit 
outgoing call.

7-digit extensions If you specified a 7-digit extension number, enter the 
internal exchange and the corresponding range of 
extension numbers from low to high. Click Add to add 
them to the list.
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Miscellaneous Tab

The Miscellaneous tab (Figure 18) sets up further dialing properties. 

NOTE:  This tab is the same for the North American and variable 
length dial string formats.

Table 7. Advanced External Dialing tab fields 

Window Section Description

Neighboring area codes 
with local dialing 
privileges

The area codes to which you can place non-toll calls. 
Click Add to add a new area code to the list and click 
Delete to remove an area code from the list.

Exchanges for 7-digit 
local numbers

Choose the neighboring area code, then enter the 
exchanges within that area code which do not require 
you to dial 1 or the area code. Check All exchanges as 
7-digit numbers if no exchange requires you to dial 1 
or an area code.

Exchanges for 10-digit 
local numbers

Choose the neighboring area code, then enter the 
exchanges within that area code that require you to 
dial the area code but not a 1. Check All exchanges 
as 10-digit numbers if all exchanges require you to 
dial an area code but not a 1.
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Figure 18. Miscellaneous tab.

To configure the miscellaneous options:

■ Select or clear the appropriate check boxes on the Miscellaneous tab as 
desired, and then click Apply to save your changes.

Table 8. Miscellaneous tab fields 

Tab Section Description

Use text from the 
clipboard as the phone 
number when pressing 
the call button

Check to enable CAD to use text on the clipboard as the 
dialed number when the Make Call button on the CAD 
toolbar is clicked, as long as the text on the clipboard is 
a valid text string.

Show the dial pad when 
using text from the 
clipboard for dialing.

Available only if “Use text from the clipboard…” is 
enabled. Check to display the dial pad before dialing a 
number copied from the clipboard. If this box is not 
checked, CAD dials the number without displaying the 
dial pad.

Convert text to digits in 
phone numbers

Converts phone numbers expressed in alpha characters 
(for example, 1-800-ANYWORD) to their numeric 
equivalents before dialing.
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Example

To illustrate how these windows would be completed in a typical North American 
company, consider the following scenario:

■ Your company is located in Minneapolis, Minnesota. The local area has 4 area 
codes: 612, 651, 763, and 952, and your company is located in the 763 area 
code. Local dialing to any of those area codes requires that you dial the area 
code, although you do not have to prefix the phone number with a “1” 
because it is not considered a long distance phone call.

■ You want all external calling and called phone numbers to be displayed in 
CAD with the following format: (NNN) NNN-NNNN. 

■ You want all internal calling and called phone numbers to be displayed in CAD 
with the following format: xNNN. All extensions in your company are 4 digits 
and begin with the number “5”.

■ You want agents to be able to dial phone numbers pasted into the PC 
clipboard whenever they click the Make Call button on the CAD toolbar, even 
if it is entered as text (for example, phone numbers like 1-800-ASK-ACME). 

To set this up, first make sure that the North American Dial String Formatting check 
box is selected. Then select the Telephone Number Display tab.

On this tab, complete the External Number Format section as follows:

The Sample field shows that external numbers will be displayed in the  
(NNN) NNN-NNNN format you want.

Complete the Internal Number Format section as follows:
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This sample field doesn’t quite reflect your choice to remove the first digit of an 
internal number—it still shows 4 digits. Your company’s extensions are 4 digits, but 
they all start with “5” so you only want to display the last 3 digits, prefixed with an “x”. 
However, you entered a “1” in the Remove first ‘n’ digits field, and selected the 
Leading ‘x’ check box, so your internal numbers will be displayed in the xNNN format. 

Next, select the Outgoing Calls tab to enter information about your local area codes.

Enter your local area code, and then configure how your company accesses outgoing 
lines:

You have to dial an “8” to access both a long distance and local line, and you want to 
automatically add a “1” to any long distance calls. 

To set up the 3 other local area codes you can dial without long distance charges or a 
“1” prefix, click the Advanced Dialing button and select the Advanced External Dialing 
tab.

You add the three area codes that are required for local dialing to the Neighboring 
Area Codes list and then click OK.

Now, any time an agent dials a 10-digit number using any one of the 4 area codes that 
are part of the local dialing area, CAD will know not to prefix the number with the “1” 
required for long distance dialing. All 10-digit numbers that do not use one of those 4 
area codes will have the “1” prefixed. 
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Finally, you select the Miscellaneous tab to enable pasting numbers from the 
clipboard into the CAD dial pad, and to enable converting text phone numbers to 
digits.

You select both the first and the second check box because you want the agent to 
have to click Dial on the dial pad to call the number pasted from the clipboard. If you 
didn’t select the second check box, the pasted phone number would be dialed 
automatically without displaying the dial pad.

To save your dialing configuration setup, you click Apply. The next time your agents 
open CAD on their desktops, phone numbers and dialing will behave as you have 
configured them.

Variable Length Dial String Format

If you choose the variable length dial string format, the following three tabs are active:

■ Telephone Number Display Tab (page 58)

■ Phone Number Format Tab (page 59)

■ Miscellaneous Tab (page 61)

Telephone Number Display Tab

The Telephone Number Display tab (Figure 19) enables you to configure how phone 
numbers are displayed in Agent Desktop. 

The selections you make are reflected in the Sample fields. (An exception is if you 
enter a value in either of the “Remove first ‘n’ digits” and “Remove last ‘n’ digits” 
fields. In that case, the sample does not change.)

NOTE:  The number of digits displayed in each section of the sample 
phone number is for illustration only. The samples do not reflect the 
number format you set up on the Phone Number Format tab.
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Figure 19. Telephone Number Display tab.

To configure the telephone number display:

■ Enter data and select or clear the appropriate check boxes and radio buttons 
on the Telephone Number Display tab as desired, and then click Apply to save 
your changes.

Phone Number Format Tab

The Phone Number Format tab (Figure 20) enables you to establish the format for 
phone numbers that do not follow the North American dial string format. You can also 
set the maximum number of digits in an internal phone extension.

Table 9. Telephone Number Display tab fields.

Tab Section Description

External number format Specify how you want to view calling and called phone 
numbers.

City/subscriber code Specify the separator you want to display between the 
city code and the subscriber code.

Internal number format Specify how internal phone numbers are displayed. You 
can include an X (extension) and remove the leading or 
trailing digits (in the event that extension numbers are 
less than 4 digits long).
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You can establish as many formats as you want, as long as each one has a unique 
total length. 

Figure 20. Phone Number Format tab.

To add a new phone number format:

1. Click Add. 

The Add City/Subscriber Code Lengths dialog box appears.

2. Enter the number of digits in the city code and the subscriber code, and then 
click OK. 

The numbers you entered are displayed in the phone number format pane, 
along with the calculated total length of the format. You cannot enter another 
format with the same total length.

3. Click Apply.

The new phone number format is saved.

To edit a phone number format:

1. Choose the number format, and then click Edit.

The Edit City/Subscriber Code Lengths dialog box appears.

2. Make your changes, and then click OK.

3. Click Apply to save your changes.
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The phone number format is changed.

To delete a phone number format:

1. Choose the number format, and then click Delete.

2. Click Apply to save your changes.

The phone number format is deleted.

Miscellaneous Tab

The Miscellaneous tab for the variable length dial string format is the same as the tab 
for the North American dial string format. 

See "Miscellaneous Tab" on page 54 for a description of the Miscellaneous Tab.
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Phone Book

Agents have several lists of phone numbers available to them:

■ The Recent Call List, a dynamic list of up to 100 recently called phone 
numbers kept by Agent Desktop

■ A personal phone book, created and maintained by the agent (and 
enabled/disabled by the system administrator)

■ Global phone books, created by the system administrator with the Phone 
Book option

The Phone Book window (Figure 21) enables you to set up and manage the global 
phone books that are shared by agents. Phone books and phone book entries are 
created and maintained in the Phone Book Editor dialog box (Figure 22).

Figure 21. Phone Book window.

Table 10. Phone Book window fields

Window Section Description

Disable all phone books Check to prevent agents from viewing global or personal 
phone books.

Disable personal phone 
book

Check to disable agents’ personal phone books.
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The Phone Book Editor enables you to set up and maintain global phone books.

To set up a new phone book:

1. In the Phone Book window, click Edit.

The Phone Book Editor dialog box appears (see Figure 22).

Figure 22. Phone Book Editor dialog box.

2. Enter a new phone book name in the Phone Books field, and then click Add.

The name of the new phone book is added to the list of phone books.

3. Click OK.

The new phone book is saved and the Phone Book Editor dialog box closes.

Phone Books Select the phone book you want to view or edit from the 
drop-down list.

Edit Click to create and edit phone books using the Phone 
Book Editor.

Table 10. Phone Book window fields

Window Section Description
December 2007 63



Cisco Desktop Administrator User Guide
To add phone book entries:

1. In the Phone Book window, choose the phone book you want to edit from the 
drop-down list, and then click Edit.

The Phone Book Editor dialog box appears.

2. Enter a name, phone number, and note (optional) for a person or company, 
and then click Add to add the information to the phone book.

The Phone Number field allows only the characters 0–9, aA–zZ, ‘ ( ) + ; / : . = 
? and a space. If you enter any other character you are advised you used a 
disallowed character. The disallowed character will be replaced by a question 
mark so you can change it to an allowed character.

3. Repeat Step 2 as needed to enter all entries to the phone book. When all 
entries are completed, click OK.

Your entries are saved and the Phone Book Editor dialog box closes.

To edit phone book entries:

1. In the Phone Book window, choose the phone book you want to edit from the 
drop-down list, and then click Edit.

The Phone Book Editor dialog box appears.

2. Choose an entry in the phone book, and then take one of these actions:

■ Click Edit, and then change the entry

■ Click Delete to delete the entry

3. When all edits are completed, click OK.

Your changes are saved and the Phone Book Editor dialog box closes.

To enable or disable phone books:

1. In the Phone Book window (see Figure 21):

■ Select or clear the Disable all phone books check box to remove agent 
access to all global phone books.

■ Select or clear the Disable personal phone book check box to remove 
access to all agents’ personal phone books.

2. Click Apply.
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Reason Codes

Reason codes describe why an agent has changed to the Not Ready agent state or 
has logged out. Reason codes are set up and maintained using the Reason Code 
window (Figure 23), and are displayed in reports generated by Cisco Supervisor 
Desktop and Cisco Agent Desktop.

Figure 23. Reason Code window.

Reserved reason codes (identified by [RESERVED] after the description) are 
predefined in Directory Services and cannot be created or deleted. You can, however, 
change a reserved reason code’s number. 

There are also CRS-generated reason codes that are entered when an agent is 
automatically put in the Not Ready state. For instance, when an agent receives a 
non-ACD call, the agent is put into the Not Ready state by CRS and the reason code 
“32761–Non-ACD Call” is entered.

The CRS-generated reason codes are:. 

Code Description

32755 Call ended

32756 Device in service
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When creating reason codes, follow these guidelines:

■ Descriptions can consist of up to 40 alphanumeric characters. No 
punctuation or other characters are allowed.

■ No agent state can contain duplicate numbers and descriptions among its 
reason codes.

■ Reason code numbers must be between 1 and 999.

■ Reason codes are either all enabled or all disabled for both the Not Ready 
and Logout agent states. You cannot enable reason codes for one state and 
disable them for another.

■ You cannot enable reason codes unless at least one user-defined reason 
code exists for Logout and one exists for Not Ready. 

To enable reason codes:

■ Select the Enable reason codes check box, and then click Apply.

If at least one user defined reason code exists for Not Ready and one exists 
for Logout, reason codes are now enabled. 

32753 Line restricted

32754 Device restricted

32757 CallManager failover

32758 Work timer expired

32759 Device out of service

32760 Logon

32761 Non-ACD call

32762 Off hook

32763 Ring no answer

32764 CRS failover

32765 Connection down

32766 Forced logout

32767 Forced login

Code Description
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To add a new reason code:

1. Choose the Logout or Not Ready tab, depending on the type of reason code 
you wish to create.

2. Enter a unique number and description for the reason code, and then click 
Add.

The new reason code is added to the reason code list.

3. Click Apply to save your changes.

To edit an existing reason code:

1. Choose the reason code you want to edit from the list. 

The reason code appears in the edit field.

2. Make your changes, and then click Edit.

The edited reason code appears in the reason code list.

3. Click Apply to save your changes.

To delete an existing reason code:

1. Select the reason code you want to delete.

The reason code appears in the edit field.

2. Click Delete.

The reason code is deleted from the reason code list.

3. Click Apply to save your changes.

To cancel your changes before saving them:

1. Do not click Apply after you have made a change. 

2. Click on another node in the Navigation pane to leave the Reason Code 
window.
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Monitor/Record Notification

The Monitoring menu is used at the global level to enable or disable messages to 
agents that they are being recorded or monitored, or both.

To enable or disable agent notification:

1. Select the Work Flow Configuration node or any of its subnodes in the 
navigation tree.

2. From the menu bar, choose Monitoring.

3. Choose Notify Monitoring and/or Notify Recording from the menu. A check 
mark appears next to the option when it is enabled. 
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Work Flow Groups

Use the Work Flow Groups option to create and configure agent work flows, to 
customize the Agent Desktop interface. 

Figure 24. Accessing Work Flow Group functions in the navigation tree.

Under the Work Flow Groups node is the Agents subnode, under which are the 
specific work flow groups. When you click on a specific work flow group node, the 
elements that make up that work flow group appear as subnodes:

■ User Interface Setup (page 72)

This subnode enables you to configure the Agent Desktop interface for the 
selected work flow group.

■ Work Flow (page 81)

This subnode enables you to create and edit work flows for the selected work 
flow group.

■ Wrap-up Data (page 115)

This subnode enables you to create and edit wrap-up data for the selected 
work flow group.

■ Enterprise Data (page 117)

This subnode enables you to configure enterprise data on the agent desktop 
for the selected work flow group.
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Maintaining Work Flow Groups

You can add, delete, or edit work flow groups. 

To add a new work flow group:

1. In the Navigation pane, choose the Agents node or work flow group subnode 
(for example, under Agents, choose the Default work flow group).

2. From the menu bar, choose File > New.

The Work Flow Group Name Editor dialog box appears.

Figure 25. Work Flow Group Name Editor dialog box.

3. Enter a new work flow group name. The name can be a maximum of 64 
characters long.

If you want to copy an existing work flow group, select the “Copy the following 
work flow group” check box and choose a work flow group from the drop-down 
list.

4. Click OK.

The new work flow group appears in the Navigation pane.

To delete an existing work flow group:

1. In the Navigation pane, choose the work flow group you want to delete.

2. From the menu bar, choose File > Delete.

You are warned that all agents belonging to the work flow group you want to 
delete must be reassigned to other work flow groups. Click Yes to confirm the 
deletion, or No to cancel it. If you do not reassign the agents, you will not be 
able to delete the work flow group.
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3. Click OK to close the dialog box.

To rename a work flow group:

1. Add a new work flow group. 

Name the new work flow group with the name you want the existing work flow 
group to be renamed.

Select the “Copy the following work flow group” check box and select the 
existing work flow group from the drop-down list.

2. Once the new work flow group is added, delete the old work flow group.
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User Interface Setup

The User Interface Setup window enables you to configure the appearance and 
behavior of Agent Desktop.

Toolbar Tab

The Toolbar tab (Figure 26) enables you to:

■ Show or hide buttons on the Agent Desktop toolbar

■ Associate actions with task buttons

■ Change task button hints

■ Customize icons

■ Enable Outbound Dialer

Figure 26. Toolbar tab.

Adding and Removing Toolbar Buttons

The pane on the left of the Toolbar tab displays the buttons that are available to be 
used on the Agent Desktop toolbar. Buttons that are assigned show an icon next to 
them; unassigned buttons do not show an icon. 
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You cannot change the hint or the shortcut key combination on any of the standard 
buttons, or assign an additional action to them. You can, however, customize the icon 
displayed on the button (see "Customizing Button Icons" on page 74).

To add a button to the toolbar:

1. In the list of buttons, select the available button you want to add.

2. Select the Visible check box, and then click Apply.

Removing a button from the toolbar:

1. In the list of buttons, select the button you want to remove.

2. Clear the Visible check box, and then click Apply.

Adding the Outbound Dialer Toolbar

The Outbound Dialer feature is available only for Agent Desktop users. 

To add an Outbound Dialer toolbar to Agent Desktop:

■ In the Outbound Dialer Mode section, select the Direct Preview dialing mode 
check box and then click Apply. 

NOTE:  The Outbound Dialer Mode section appears on the Toolbar tab 
and Outbound Dialer icons appear in the icon pane only if Outbound 
Dialer is enabled in Directory Services and an Outbound Dialer 
license is available. If these conditions are not met, this section is 
blank.

The Outbound Dialer buttons are added to the Agent Desktop toolbar. 

For more information, see "Cisco Unified CCX Outbound Preview Dialer" on 
page 109.

Associating Actions with Task Buttons

You can associate as many actions with a task button as you wish. The actions are 
executed sequentially in the order they are listed in the Actions window. 

NOTE:  Bear in mind the amount of time it takes to execute actions. 
Generally, a maximum of two or three actions per task button is 
recommended.

The default task buttons display icons of the numbers 1 through 10. You can 
customize these icons if you wish.
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To associate an action with a task button:

1. Select a task button from the list of available buttons. 

2. Select the Visible check box.

The Actions pane and its associated buttons become enabled.

3. Under the Actions pane, Click Add.

The Select Action window appears. 

4. Select the action you want to associate with the button.

You can select an existing action or set up a new action. (See "Actions" on 
page 86 for more information on setting up new actions.)

5. Click OK.

The Toolbar tab is displayed.

6. Type a short description of the action in the Hint field. You can replace only 
the hint; you cannot change the shortcut key combination.

7. Repeat Steps 3–6 if you want to add other actions to the same task button. 

8. Click Apply to save your changes.

Changing a Task Button’s Hint

You can change the hint (the text an agent sees when the mouse hovers over a 
button) associated with a task button. 

You cannot change the hint associated with a standard button, or change the shortcut 
key combination of any button.

To change a task button’s hint:

1. Select the button whose hint you want to change.

2. In the Hint field, type the hint you want displayed to the agent.

3. Click Apply to save your changes.

Customizing Button Icons

Buttons can be customized by applying different icons to them. A library of available 
icons is supplied with Desktop Administrator, or you can use icons of your own.

If you use your own icons, when applied to a button the icon file is written to Directory 
Services so it is available to all instances of Agent Desktop. 

Custom icons must meet the following specifications.

■ ICO format

■ 16 × 16 or 32 × 32 pixels
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■ up to 256 colors

To customize an icon:

1. Choose the button whose icon you want to customize.

2. Click Customize Icon.

The Choose Icon dialog box appears (see Figure 27).

Figure 27. Choose Icon dialog box.

3. Choose an icon. 

The icon is displayed in the Preview area.

You can also click Browse to navigate to another location if you wish to use 
your own icon. 

4. Click OK. 

The button is displayed with the new icon on it in the button list.

Show Data Fields Tab

The Show Data Fields tab (Figure 28) configures the data fields that appear in the 
contact appearance pane in Agent Desktop. This tab can also be used to rename 
those data fields. 

The left pane displays the fields that appear in Agent Desktop. The right pane displays 
the fields available. Use the left and right arrows to move the available fields between 
the two panes, and the up and down arrows to set the left-to-right order in which they 
appear in Agent Desktop.
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NOTE:  The left pane must contain at least one field.

Figure 28. Show Data Fields tab.

To rename a data field:

1. Double-click the field.

The Rename dialog box appears. 

Enter a new name, and then click OK.

2. Click Apply to save your changes.

Miscellaneous Tab

Use the Miscellaneous tab (Figure 29) to set other user interface options.
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Figure 29. Miscellaneous tab.

Table 11. Miscellaneous Tab fields 

Option Description

Window Behavior Specify how you want the Agent Desktop window to 
behave. The default setting is Agent’s Choice.

• Normal. The window appears when calls are present 
and minimizes when idle.

• Keep Open. The window is always visible, but can be 
hidden by other open applications.

• Always on Top. The window is always visible and on 
top of other open applications.

• Stealth. The window appears as an icon in the 
system tray.

• Agent’s Choice. Behavior is set locally by the agent. 
The local setting persists until reset or until you 
choose something other than Agent’s Choice. On the 
agent’s desktop, the default setting is Normal.

Macro Hot Key Specify the key you want to use to pause macro 
recording and display the Suspend Macro Recording 
dialog. The default is F2.
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IPPA Tab

Select the check box on the IPPA tab (Figure 30) to enable agent-initiated recording for 
IP Phone Agent users. This option is available only if you have the Enhanced or 
Premium version of CAD.

Figure 30. IPPA tab.

Browser Setup Tab

Use the Browser Setup tab (Figure 31) to configure the Integrated Browser portion of 
Agent Desktop. This option is available only in the Premium version of CAD.

On this tab you can:

■ Enable/disable the integrated browser window

■ Set the default web page displayed by the browser

Rules and Actions only 
apply to the first call 
appearance

Check to invoke rules processing only for the oldest (top) 
call appearance. If the box is not checked, rules 
processing is invoked for all inbound calls.

Table 11. Miscellaneous Tab fields — Continued

Option Description
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■ Enable/disable agents’ access to other websites 

■ Add work sites (or “favorites”) so agents can quickly access frequently-used 
websites

Figure 31. Browser Setup tab.

Enabling the Integrated Browser

You can enable/disable the integrated browser in Agent Desktop by selecting or 
clearing the Enable Integrated Browser check box at the bottom of the Browser Setup 
tab.

Enabling Access to Other Websites

You can enable/disable an agent’s access to other websites by selecting or clearing 
the Allow Address Editing check box. When selected, the Address field appears in the 
integrated browser window, and agents can enter the URL of a website they wish to 
view.

When disabled, the Address field does not appear in the integrated browser window.

Setting Up the Home Page

A home page is the website that appears in the integrated browser when Agent 
Desktop is started. The default website is www.cisco.com. 

If no home page is configured (the default is deleted), the integrated browser displays 
a message that no home page has been set up.
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To configure a home page:

1. In the Home Page field, type the web address (URL) of the website you want to 
appear by default in the integrated browser.

2. Click Apply to save your changes.

The home page is set. 

Setting Up Work Sites

A work site is a website that is frequently accessed by agents to assist them in their 
jobs. They are similar to the “favorites” you can set up in a web browser. 

Work sites you set up appear in a drop-down list in the agent’s integrated browser. 
When the agent selects a work site from the list, it is displayed in the integrated 
browser window. This allows the agent quick access to the site without having to type 
its address in the (optional) Address field.

To add a work site:

1. In the Site Name field, type the name of the website you wish to add as a work 
site.

2. In the URL field, enter the web address of the website.

3. Click Add.

The work site is added to the list in the Work Sites pane.

4. Click Apply to save your changes.

To update a work site:

1. In the Work Sites field, select the work site you wish to update. 

The information for the website appears in the Site Name and URL fields.

2. Edit the information as needed, and then click Update.

The updated information appears in the Work Sites pane.

3. Click Apply to save your changes.

To delete a work site:

1. In the Work Sites pane, select the work site you wish to delete.

The information for the website appears in the Site Name and URL fields.

2. Click Delete.

The work site is deleted from the Work Sites pane.

3. Click Apply to save your changes.
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Work Flow

A work flow is a sequence of actions that takes place when a specific call event 
occurs. Use the Work Flow Setup window (Figure 32) to set up a work flow. 

To set up a work flow, you must configure the following three functions:

■ Event. An occurrence. Available events are startup, shutdown, ringing, 
answered, and dropped.

■ Rule. A data condition that must be met before an action is performed.

■ Action. An occurrence that happens when a rule is met.

When an event occurs, rules are evaluated. If a rule is met, an action takes place. For 
instance, a work flow could be set up so that an incoming call from a specific phone 
number is transferred to a specific agent:

■ The event is Answered;

■ The rule is that the incoming phone number is 612-555-3271;

■ The action is a blind transfer to agent Mary Jones.

The general procedure for setting up a work flow is:

1. Select the event that triggers the work flow.

2. Set up one or more rules to determine if the action(s) should be run, and 
determine whether the action runs if either any of the rule’s data conditions 
are met, or if all the rule’s data conditions are met. 

3. Choose one or more actions to run when the event occurs and the rules are 
met. Actions run in the order in which they appear in the list.
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Figure 32. Work Flow Setup window.

Table 12. Work Flow Setup window fields 

Window Section Description

Events Select the occurrence to associate with rules and 
actions.

Rules  
(of current Event)

Specify the rules to associate with the selected event.

Actions  
(of current Rule)

Specify the actions to associate with the selected rule.

Current Rule Conditions Enable Rule. Check to put the rule into effect.

Execute Actions When. Check either Any Condition is 
True or All Conditions are True. This sets the data 
conditions for the rule to “Or” or “And” statements.

Data Field Conditions. Specify up to 3 data field 
conditions set up for the rule. Click the Edit button next 
to each condition to create or edit it. 
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Events

Events are application and call occurrences in Agent Desktop. Available events are:

Rules

A rule is a set of one to three data field conditions. Each data field condition is set up 
separately. 

When an event occurs, the rules associated with the event are executed in the order 
they are listed in the Work Flow Setup window (Figure 32).

When a rule is met, the actions associated with that rule are executed in the order 
they are listed in the Work Flow Setup window. Subsequent rules are not evaluated.

If no rules are met, the default rule governs, and all actions associated with the 
default rule are executed. 

NOTE:  The default action might be <no action>. Default rules cannot 
be changed or deleted.

You can specify that an action is to be run if any data condition is true or if all data 
conditions are true by selecting the appropriate check box in the Work Flow Setup 
window.

Setting Up a New Rule

To set up a new rule:

1. From the Work Flow Setup window, under the Rules area, click New.

The New Rule Name dialog box appears (Figure 33).

2. Enter an appropriate name for the new rule, and then click OK. 

Table 13. Work flow events

Event Description

Startup Agent Desktop starts on the agent’s computer. No rules can be 
assigned to this event.

Shutdown Agent Desktop shuts down on the agent’s computer. No rules 
can be assigned to this event.

Ringing The agent’s phone rings.

Answered The agent answers an incoming phone call.

Dropped The agent’s inbound call is terminated.
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The new rule is now listed in the Rules pane in the Work Flow Setup window. 
You many now set up one to three data field conditions to apply to the new 
rule.

Figure 33. New Rule Name dialog box.

3. With the new rule selected, click Edit next to the first Data Field Conditions 
field.

The Data Field Conditions dialog box appears. 

Figure 34. Data Field Conditions dialog box

4. Select a data field from the Data Field drop-down list.

5. Specify one of the data field filters:

Table 14. Work flow data field filters 

Filter Description

Is Empty Data field is empty.
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6. Check Enable Condition, and then click OK. 

The rule is now set up. You must associate it with an action and enable it in 
the Work Flow Setup window to put it into effect.

Wild Card Searches
You can use wild cards when entering items in the list pane in the Data Field 
Conditions dialog box. This enables you to avoid having to enter whole strings if the 
items you wish to list have common string elements. 

Wild card characters used are the asterisk (*) and the question mark (?). 

Asterisk wild card.  An asterisk in a string can be replaced by any quantity of any 
character, as long as the other characters in the string match. For instance:

■ ABC* matches ABCD, ABCDEERRGFG, and ABC$@, among others. All these 
matches start with ABC.

Is Not Empty Data field is not empty.

Is in the List Data field is compared to the list you set up in the List 
pane to determine if it is in that list. Click Add to add an 
item to the list of strings. Strings are not case sensitive.

Note: Items in the list can not include commas.

For more information on adding strings, see "Wild Card 
Searches" on page 85.

In Not in the List Data field is compared to the list you set up in the List 
pane to determine if it is not in that list. Click Add to add 
an item to the list of strings. Strings are not case 
sensitive.

Note: Items in the list can not include commas.

For more information on adding strings, see "Wild Card 
Searches" on page 85.

Length of Data Data field is within a specified range set in the Length of 
Data fields. Typical use is to differentiate between 
internal and external calls. Internal calls are 4-digit 
numbers, and external calls are 8- to 12-digit numbers. 

Enter the minimum and maximum length of data fields. 

Note: if your dial plan is set up to preface internal 
numbers with an “x”, the data condition must also 
include an “x”.

Table 14. Work flow data field filters — Continued

Filter Description
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■ *ABC matches DDABC, @#ABC, and 1234ABC, among others. All theses 
matches end with ABC.

Question mark wild card.  A question mark in a string can be replaced by any 
character, but the length of the string must be exactly as represented. For instance:

■ ABC? matches ABCD, ABC1, and ABC$, among others. The character 
represented by the question mark doesn’t matter, but the length of the string 
must be four characters.

■ ??ABC matches 12ABC, $%ABC, and FEABC, among others. The two 
characters at the beginning of the string can be replaced by any character, 
but the length of the string must remain five characters.

Actions

Actions include:

■ Run Macro Action (page 88). Play back a recorded sequence of keystrokes. 

■ Call Control Actions (page 96). Answer, drop, call, conference, or transfer a 
call, or input touch tones during a call.

■ HTTP Action (page 97). Use call-based data to interact with a website or a web 
application in the Integrated Browser window.

■ Launch External Application Action (page 102). Start a third-party application. 

■ Agent State Action (page 104). Set an agent state. 

■ Utility Action (page 107). Run a utility, such as start and stop recording or 
sending a predefined, high-priority chat message to a supervisor. 

Actions are stored independently of events and rules. You can use an action in more 
than one event, and you can assign actions to more than one task button in Agent 
Desktop.

While actions are being processed, events are queued. For this reason, it is generally 
a good idea to avoid actions that take a long time to execute.

To add a new action:

1. In the Work Flow Setup window, select the event to be associated with the 
new action.

2. Under the Actions area, click Add.

The Select Action dialog box appears (see Figure 35).
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Figure 35. The Select Action dialog box.

3. Choose the tab for the type of action you want to associate with the event. 

4. If the action already exists, select it, and then click OK.

If the action does not yet exist, click New and follow the instructions for 
setting up that type of action.

5. Click OK.

The Select Action dialog box closes and you return to the Work Flow Setup 
window. The new action is listed in the Actions pane.

To edit an action:

1. In the Work Flow Setup window, select the appropriate event, and then select 
the action you want to edit from the Actions pane. 

2. Click Edit.

One of several edit action dialog boxes appears (depending on the action you 
have chosen to edit).

3. Make your changes, and then click OK.

The action is now changed.

To permanently delete an action:

To permanently delete an action, you must first delete it from any event or 
task button it is associated with, and then delete the action itself. 
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1. In the Work Flow Setup window, select each event, and then each rule 
associated with that event. If the action you want to delete is associated with 
a rule, select the action in the Action pane and click Delete to remove it from 
that rule.

The action is now removed from all events and rules.

2. Under the Actions pane, click Add.

The Select Actions dialog box appears.

3. Choose the appropriate tab, and then select the action you want to delete.

4. Click Delete.

The action is deleted.

5. Click OK.

The Select Action dialog box closes and you return to the Work Flow Setup 
window. 

Run Macro Action

A macro is a shortcut for a sequence of keystrokes. For example, you might record a 
macro that performs the following tasks with each incoming call:

■ Copy the ANI (Automatic Number Identification—the calling number) from 
Agent Desktop to Microsoft Outlook

■ Open a contact list

■ Find the calling number in a database or spreadsheet

■ Display a window containing the caller’s account information

NOTE:  Do not use a Run Macro action to perform tasks that can be 
accomplished by one of the other types of actions available. For 
example, use a Call Control action to transfer a call, and an Agent 
State action to change agent states.

For examples of creating macros, see Chapter 6, “Tutorials.”
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Figure 36. Run Macro tab.

Macro Recording Tips
If your macro accesses a third-party application, make sure that the application is 
open. Before you begin to record the macro, make a test run with the third-party 
application, writing down all of the keystrokes required for the tasks you wish to 
perform.

Avoid using:

■ the tab or arrow keys in your macro because the cursor might not always be in 
the same position each time a window opens

■ mouse clicks and movements, because the macro recorder does not record 
them

Rather, use keyboard shortcut keys to perform actions in the application.

NOTE:  When a macro is executed, it can be impacted by the current 
keyboard settings of the client PC. Care should be taken to ensure 
that keyboard settings, such as Caps Lock, are not inadvertently left 
on. Agents should also be cautioned not to enter keystrokes while a 
macro is running, since that can also affect the macro.
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Shortcut keys are indicated by an underlined letter in the button name, field name, or 
description. You press Alt, Ctrl, or Shift plus the underlined letter to perform the 
action. For instance:

In this case, pressing Alt-E clicks the Edit button.

NOTE:  The exact keystrokes for a keyboard shortcut are listed in the 
application’s menu. For instance, in Microsoft Word, to find out what 
the shortcut is to save a document, choose File from the menu bar. 
On the drop-down menu the Save option is followed by its shortcut, 
Ctrl-S.

Common Windows shortcut keys are:

A macro can include keystrokes for multiple applications. For example, one macro can 
include keystrokes for word processing, spreadsheet, and database applications. 

To switch between applications when recording a macro, use the mouse to select the 
application. Do not press Alt-Tab. If you do, these keystrokes are recorded and can not 
select the correct application when you play back the macro.

NOTE:  Do not press Ctrl-Esc to click the Microsoft Windows Start 
button or Ctrl-Alt-Delete to launch the Windows Task Manager, or the 
Macro Recorder stops recording without providing a message 
showing that recording has stopped. All keystrokes recorded up to 

Table 15. Windows shortcut keys

Shortcut Key Description

Esc Cancels an action.

Enter Clicks OK or the default button in a dialog box. (Default 
buttons have a heavier border surrounding them.)

Ctrl-A Selects all text.

Ctrl-C Copies selected text to the clipboard.

Ctrl-P Prints the document.

Ctrl-S Saves the document.

Ctrl-V Pastes text into the window at the cursor position.

Ctrl-X Cuts selected text to the clipboard.
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this point are deleted. To click Start without causing an error or 
stopping recording, use your mouse.

Allowable Macro Keystrokes

Table 16. Allowable macro keystrokes 

Key Type Key Macro Notation

Character 0 1 2 3 4 5 6 7 8 9

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

* + ; = , - . / ` [ \ ] '

Non-Character Tab [TAB]

Backspace [BACKSPACE]

Enter/Return [ENTER]

Shift [SHIFT]

Control/Ctrl [CONTROL]

Alt [ALT]

Pause/Break [PAUSE]

Caps Lock [CAPSLOCK]

Esc [ESC]

Space/Space Bar [SPACE]

Page Up/PgUp [PAGE-UP]

Page Down/PgDn [PAGE-DOWN]

End [END]

Home [HOME]
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Recording Macros

To record a macro:

1. Start any third-party applications you want to include in the new macro, and 
then minimize them.

2. Choose the appropriate work flow group in the Desktop Administrator left 
pane, and then click Work Flow.

Non-Character 
(continued)

Left Arrow [LEFT-ARROW]

Up Arrow [UP-ARROW]

Right Arrow [RIGHT-ARROW]

Down Arrow [DOWN-ARROW]

Print Scrn [PRINTSCREEN]

Insert [INSERT]

Delete [DELETE]

F1 through F24 [F1] … [F24]

Table 17. Special macro keystroke commands

Special Command Description

[ENTERPRISE FIELD:] Inserts an Enterprise Data field.

[DATA FIELD:] Inserts data from Agent Desktop.

[SYSTEM FIELD:] Inserts data from Agent Desktop system fields.

[APPLICATION:=] Changes focus to an application window. The equal sign 
( = ) is used as a separator between the application and 
the window title. If either the application name or window 
title is missing, Agent Desktop attempts to find the correct 
application and window to play the macro to, based on the 
parameters present.

[DELAY] Time, in milliseconds, to wait before performing the next 
macro command.

Example: [DELAY] 1000 delays the next macro key or 
command by 1 second.

Table 16. Allowable macro keystrokes — Continued

Key Type Key Macro Notation
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The Work Flow Setup window appears.

3. Under the Actions pane, click Add.

The Select Action dialog box appears.

4. On the Run Macro tab, click New.

The New Macro dialog box appears.

5. Enter a new macro action name, and then click OK. 

The Macro Editor window appears (Figure 37).

Figure 37. Macro Editor window (with a macro script displayed; the window name is the name 
of the macro).

6. Click Record. 

The Macro Editor window minimizes and the macro recorder starts. Anything 
you type from now on is entered in the new macro.

7. Maximize the third-party application and begin typing.

The macro recorder records your keystrokes.

8. If you wish to insert a Agent Desktop data field into the macro, press the 
Pause Macro hot key (default is F2). 

The Macro Recorder Suspended dialog box appears (Figure 38). 
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NOTE:  Do not change the window focus away from the third-party 
application to the macro recorder before pressing the Pause Macro 
hot key and attempting to insert a data field. If you do this, you will 
receive an error message and your macro recording will be 
interrupted.

Figure 38. Macro Recorder Suspended dialog box.

9. Click Insert Data.

The Select a Data Field dialog box appears (Figure 39). See "Data Fields" on 
page 95 for more information.

Figure 39. Select a Data Field dialog box.
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10. Choose the desired data field from the list, enter test data if desired, and then 
click OK. 

The test data you enter is displayed in the application only when the macro is 
tested using the Playback option.

The Macro Recording Suspended dialog box appears.

11. Click Resume Recording to continue recording the macro.

12. Once you have finished recording the macro, press the macro hot key.

The Macro Recording Suspended dialog box appears.

13. Click End Recording.

You are returned to the Macro Editor window. 

14. You can take the following actions:

■ Click OK to save the macro as recorded.

If there are no errors, the macro is saved and you are returned to the 
Select Action dialog box. 

If there are errors, the macro editor displays the line and highlights the 
text in question. Correct it and click OK again. 

■ Click Playback to test the macro.

If there are errors, the macro editor displays the line and highlights the 
text in question. Correct it and click Playback again.

If there are no errors, the macro is played back. If it works as you want it 
to, click OK to save it and return to the Select Action dialog box.

To change test data, choose Data > Change Test Data in the macro editor 
and enter new test data.

■ Click Cancel to cancel the macro.

The macro is canceled and the Select Action dialog box appears.

Data Fields
The Select a Data Field dialog box enables you to select and insert a Agent Desktop 
data field into a macro. Access this dialog box either through the Suspend Macro 
Recording dialog box or from the Data menu in the Macro Editor window.

There are three types of data fields:

■ Standard. Data from the switch.

■ System. System data, for example the date and time. These fields are 
enclosed in square brackets [field name].

■ Enterprise. Data from the Enterprise service. These fields are marked with an 
asterisk (*). If this service is not installed, these fields are not available.
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See “Work Flow Data Fields” on page 113. for a list of the available data fields and 
their descriptions.

NOTE:  When selecting data fields to be used in actions or rules, keep 
in mind that not every data field is available for every event. For 
example, the calling number is not available during the Startup event. 
If an unavailable field is used, <N/A> is displayed in the application 
the macro pops.

Call Control Actions

Call Control actions assign a call control to an event. 

To set up a new call control action:

1. In the Work Flow Setup window, choose the event to associate with the new 
action.

2. Under the Actions area, click Add.

The Select Action dialog box appears.

3. Choose the Call Control tab, and then click New.

The Call Control Action Setup dialog box appears (Figure 40).

Figure 40. Call Control Action Setup dialog box.

4. Enter the following information, and then click OK.

■ A name for the call control action

■ The type of action (select from the drop-down list)

■ A phone number if required by the type of action (for example, for Blind 
Transfer, enter the phone number to which a call is transferred)

The Select Action dialog box appears. The new call control action has been 
added to the list of available actions.
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HTTP Action

HTTP actions enable an agent to use call-based data to interact with a website or a 
web application in the Integrated Browser window. This option is available only if you 
have the Premium version of CAD.

For example, an HTTP action can be set up so the enterprise data of an incoming call 
is used to retrieve a customer record and display it in the Integrated Browser. 

NOTE:  For more information on HTTP requests and the HTTP protocol 
in general, see the website of the World Wide Web Consortium, 
www.w3.org.

To set up an HTTP action:

1. Set up a new action. See "To add a new action:" on page 86.

The Select Action window appears.

Select the HTTP Action tab, and then click New.

The HTTP Actions Setup dialog box appears. (See Figure 41.)

2. Complete the HTTP Actions Setup dialog box as follows:

Field Description

Action Name Enter a name for the new action.

Protocol Select the protocol to be used by the browser: http 
(default) or https.

Method Select the http method to be used by the browser: GET 
(default) or POST.

Host Enter the host name or IP address of the website. Do not 
include the http or https prefix.

Port Enter the port (0–65535) that the host is listening on (for 
http the default is 80; for https, the default is 443). 

Path Enter the path portion of the URL (optional). Default is 
blank. Do not include a leading slash.
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Figure 41. HTTP Actions Setup dialog box.

3. Click Add to display the HTTP Request Data dialog box. (See Figure 42.)

The fields added with this dialog box make up the query or post data portion 
of the request. The fields are optional and are blank by default.

Figure 42. HTTP Request Data dialog box
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4. Complete the HTTP Request Data dialog box as follows:

5. Continue to build your request using the Add, Edit, and Delete buttons as 
needed.

6. When you have completed building the request, click Preview to view the 
request. Note that Desktop Administrator has added the special characters 
needed for a valid HTTP request. 

■ If a path is specified and there is request data, there will be a “/” after the 
port and a “?” after the path.

Example: http://www.site.com:80/index.jsp?name=value

■ If a path is not specified, there is request data, and the first request data 
is not DataFieldOnly, there will be a “?” after the port and no “/”.

Example: http://site.com:80?name=value

■ If a path is not specified, there is request data, and the first request data 
is DataFieldOnly, there will be a “/” after the port and no “?”.

Example: http://www.site.com:80/value

■ If a path is not specified, there is more than one request data, and the 
first request data is DataFieldOnly, there will be a “/” after the port and no 
“?”.

Field Description

Value Name Enter the name of the field in the web application.

Value Type Select one of the following:

• DataField to use an enterprise data variable as the 
source of the data. This is inserted in the URL 
following the <name>=<value> format.

• UserDefined to use a specific string entered in the 
Value field. This is inserted in the URL following the 
<name>=<value> format.

• DataFieldOnly to insert any value selected from the 
Valuedrop-down list without following the 
<name>=<value> format.

Value If you selected a value type of DataField or 
DataFieldOnly, select the enterprise data variable from 
the dropdown list. If you selected UserDefined, enter the 
value to be used.

Test Data Enter a string of test data to simulate DataField or 
DataFieldOnly data. This field is enabled only if you 
select a Value Type of DataField or DataFieldOnly.
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Example: http://www.site.com:80/value&value&value…

7. When you are satisfied your request is correctly formatted, click Test to test it 
using the test data you entered when adding the request data.

Reserved Characters
There are characters that must not be used in an HTTP request. These characters are:

Example of an HTTP Request
To illustrate how to create a basic HTTP request, we will write a request that uses the 
Google search engine to search the web for “Cisco Systems.” 

To learn what value names and values go into the Google search:

1. Open your web browser and navigate to www.google.com. 

2. Type Cisco Systems in the search field and then click Google Search. 

The address bar shows the HTTP request we will create in Administrator. (See 
Figure 43.)

Table 18. HTTP request reserved characters 

Symbol Description Symbol Description

& Ampersand [ Left square bracket

@ At sign % Percent

\ Back slash + Plus

^ Carat # Pound sign

: Colon ? Question mark

, Comma > Right angle bracket

$ Dollar sign ] Right square bracket

“ Double quote ; Semicolon

= Equal sign ‘ Single quote

! Exclamation point / Slash

< Left angle bracket
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Figure 43. Google Search results page. 

3. The Address bar shows this string:

www.google.com/search?ie=UTF-8&oe=UTF-8&sourceid=gd&q=Cisco+ 
Systems&wxob=0

The portion of the string before the question mark is the host and the path. 
After that, all the request data is listed, separated by ampersands ( & ). 

To create the HTTP request:

1. Complete the HTTP Actions Setup dialog box with the information you 
gathered from the manual Google search (see Figure 2). 

The values are all user-defined. The value name is on the left side of the 
equal sign, and the value is on the right side of the equal sign.

Note that Google inserted a plus sign (+) between the words Cisco and 
Systems in the request string. You do not need to include that character in the 
HTTP Request Data dialog box. Desktop Administrator will add an acceptable 
string to indicate the space between the words.

Name Value

Host www.google.com

Path search

Request Data ie=UTF-8

oe=UTF-8

sourceid=gd

q=Cisco+Systems

wxob=0
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2. After you have entered the request data, click Preview to view the resulting 
request string. 

It should be identical to the string displayed in the Google search results 
address bar. If you used a plus sign between the words Cisco and Systems, 
you will see “%2B” instead of the plus sign; if you used a space, you will see 
“%20”. These strings indicate a space and are an acceptable substitute for 
the plus sign.

3. Click Test to test your HTTP request. 

The request should open your browser, navigate to the Google Search page, 
and run a search for Cisco Systems.

Figure 44. Google Search HTTP Action Setup dialog box.

Launch External Application Action

Launch actions start a third-party application in a new window. 

To ensure applications are running before macros attempt to use them, start them 
with launch actions assigned to the Startup event.
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NOTE:  An application started by a launch action must use the same 
path on the agent’s PC as it does on the administrator’s PC or it must 
be on a network drive, or the launch action will not be successful.

When using launch actions, Agent Desktop can pass parameters, such as command 
line arguments, in two ways. 

The first method is to add parameters after the application path name. For example, 
the command to start Microsoft Excel and open a spreadsheet named mrmtest.xls is:

“c:\program files\excel.exe” “c:\my documents\mrmtest.xls”

NOTE:  Program names and command line arguments that contain 
spaces must be in quotes so that they appear as one argument 
rather than as multiple arguments.

The second method involves passing data fields as arguments. You can pass any valid 
data field while launching an application. Note that if a launch action takes place on 
the Startup event, call data can not be present. Empty or blank data fields will contain 
the string <NULL>.

To set up a new Launch External Application action:

1. In the Work Flow Setup window, choose the event to associated with the new 
action.

2. Under the Actions pane, click Add.

The Select Action dialog box appears.

3. Choose the Launch External Application tab, and then click New.

The Launching External Application Action Setup dialog box appears (Figure 
45).
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Figure 45. Launching External Application Action Setup dialog box.

4. Enter a name for the action and enter the path to the desired application’s 
location.

Make sure the application is located so that it is available to Agent Desktop at 
runtime.

5. Add any arguments you wish to pass to the application. 

Choose the desired argument in the Available Arguments list, and use the left 
arrow to add it to the Argument list. Use the up and down arrows to reorder 
the Argument list.

See “Work Flow Data Fields” on page 113. for a list of the available data fields 
(arguments) and their descriptions.

6. When you have finished entering information, click OK. 

The Select Action dialog box appears. The new Launch External Application 
action has been added to the list of available actions.

Agent State Action

Agent State actions enable you to select an agent state to associate with an event.

To set up a new agent state action:

1. In the Work Flow Setup window, choose the event to associate with the new 
action.

Agent State actions can be associated only with Answered and Dropped 
events.
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2. Under the Actions pane, click Add.

The Select Action dialog box appears.

3. Choose the Agent State tab, and then click New.

The Agent State Action dialog Setup box appears (Figure 46).

Figure 46. Agent State Action Setup dialog box.

4. Enter a name for the action, select the agent state control from the drop-down 
list, and then click OK. 

The Select Action dialog box appears. The new Agent State action has been 
added to the list of available actions.

Automated Reason Codes for Agent State Changes
You can enable automated reason codes when you set up an agent state action for 
transitioning to Logout or Not Ready. 

If you enable automated reason codes, the agent does not have to choose the 
appropriator reason code when an agent state action to transition to Logout or Not 
Ready is triggered.

To enable automated reason codes

1. Follow Steps 1–3 in the procedure for setting up a new agent state action on 
page 104. 

2. In the Agent State Action Setup dialog box, enter a name for the action, select 
either AgentNotReady or AgentLogout from the Agent State Control drop-down 
list. 

The Automate Reason button appears in the dialog box (Figure 47). 
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Figure 47. Agent State Action dialog box with Automate Reason button.

3. Click Automate Reason. 

The Select Reason dialog box appears.

Figure 48. Select Reason dialog box.

4. Select the reason code you want to be entered automatically when the action 
is triggered, and then click OK.

The default is “Agent will choose.” If you select this, the agent will have to 
manually enter the reason code. 

The dialog box closes and the Agent State Action Setup dialog box is 
displayed, with the number of your chosen reason code entered in the gray 
box next to the Automate Reason button. 

5. Click OK. 

The Select Action dialog box appears. The new Agent State action has been 
added to the list of available actions.
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Utility Action

Utility actions set up actions such as starting and stopping recording or sending a 
predefined, high-priority chat message to the agent’s supervisor.

High-Priority Chat Messages
A high-priority chat message is a predefined message that appears in a supervisor’s 
Chat window (see Figure 49). The message behaves just like a regular chat message 
that is tagged as high priority—it pops up on the supervisor’s desktop on top of all 
other windows to attract the supervisor’s attention. 

You can configure a task button on the Agent Desktop toolbar to send such a 
message from an agent to the agent’s supervisor(s). 

Figure 49. Sample high-priority chat message.

To set up a new utility action:

1. In the Work Flow Setup window, choose the event to associate with the new 
action.

2. Under the Actions pane, click Add.

The Select Action dialog box appears.

3. Choose the Utility Action tab, and then click New.

The Utility Action Setup dialog box appears (Figure 50).
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Figure 50. Utility Action Setup dialog box.

4. Enter a name for the new action, and select an action type from the 
drop-down list.

■ If you select Record as the action type, select Start or Stop from the 
Action field. 

■ If you select HighPriorityChat, type the message you want to send as the 
predefined, high-priority chat message in the Message field.

NOTE:  When the dialog box initially opens, only the Action Name and 
Action Type fields are visible. When you choose the Record action 
type, the Action field appears. When you choose the High Priority 
Message action type, the Message field appears.

5. Click OK.

The Select Action dialog box appears. The new Utility action has been added 
to the list of available actions.
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Cisco Unified CCX Outbound Preview Dialer

Cisco Unified Outbound Preview Dialer (Outbound Dialer) is a Unified CCX feature that 
enables automated outbound dialing to customers. These outbound calls appear as 
inbound calls to the agent, and information about the call appears in the Enterprise 
Data pane.

NOTE:  Outbound Dialer is available only for Cisco Agent Desktop.

A supervisor or administrator sets up a calling campaign in CRS that consists of 
various elements that will present calls to agents and provide information so the 
agent can handle the call successfully. (See the Cisco CRS Administration Guide for 
information on setting up calling campaigns.)

Outbound Dialer uses the Direct Preview Dialing Mode. In this mode, an agent is 
reserved and then presented with a customer call along with customer information in 
the Enterprise Data window. Based on this information, the agent can decide to 
accept, skip, or reject the call. The agent can also categorize the phone call presented 
as Voice, Answering Machine, Invalid, or Fax Modem.

The personal callback feature enables an agent to reschedule a customer call at the 
customer’s request for a more convenient time. 

Callbacks can be configured so that, when the call is redialed, the call is directed to 
any agent (regular callback) or the call is directed to the agent who made the callback 
reservation (personal callback). The callback type is configured at the campaign level 
and is not controlled by the agent. 

Outbound Dialer Actions

Based on the enterprise data information, the agent selects the appropriate 
Outbound Dialer action button on the Outbound Dialer toolbar.

The available Outbound Dialer actions and their associated toolbar buttons are 
displayed in Table 19.

Table 19. Outbound Dialer actions and associated toolbar buttons. 

Button Action Description

Accept The system dials the customer and connects the call 
to the agent.

Reject The system rejects the current call and releases the 
agent from the outbound calling reservation. At this 
point, the system may deliver to the agent another 
outbound call or a new inbound call.
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Outbound Dialer Toolbar

In order for the Outbound Dialer actions to be available for agents to use, you must 
configure the agent interface to include the Outbound Dialer toolbar. 

NOTE:  You cannot prevent and agent from receiving Outbound Dialer 
calls by removing the Outbound Dialer toolbar from the agent’s 

Reject Close The system rejects the current call and closes the 
record so the customer will not be called again.

Skip The system skips the current call and presents the 
agent with another customer call.

Skip Close The system skips the current call and closes the 
record so the customer will not be called again.

Skip-Next The system skips the call and displays a menu of 
these options: 

• Wrong Number. The agent is informed that the 
number called is a wrong number. After the call 
terminates, the system calls other customer phone 
numbers.

• Not Home. The agent is informed that the 
customer is not home. After the call terminates, 
the system calls other customer phone numbers.

Callback Displays the Callback Properties dialog box, which the 
agent uses to set a time and date to call back the 
customer. This action is enabled only if the agent is in 
the talking or wrap-up agent state. The agent also 
uses this dialog box to cancel a previously-scheduled 
callback of the current customer. This action works 
only if the agent is in a talking or wrap-up state during 
a CRS-generated call. 

Reclassify Displays a menu that enables the agent to reclassify a 
customer phone number as voice, answering 
machine, fax/modem, or an invalid number.

Cancel 
Reservation

The system releases the agent from the calling 
campaign and places the agent in the Not Ready 
state. To resume participating in the calling campaign, 
the agent must change the agent state to Ready. 

Table 19. Outbound Dialer actions and associated toolbar buttons. — Continued

Button Action Description
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desktop. The agent must also be removed from the contact service 
queue that is handling the Outbound Dialer calls.

To configure the Outbound Dialer toolbar to display in Agent Desktop:

1. In the User Interface window, select the Toolbar tab. 

2. In the Outbound Dialer Mode section, select the Direct Preview check box 
(see Figure 51). 

The appropriate buttons are enabled in the button selection pane.

NOTE:  Instead of selecting the Direct Preview check box and enabling 
all Outbound Dialer buttons, you can configure selected Outbound 
Dialer toolbar buttons to appear on the Agent Desktop interface. See 
"Adding and Removing Toolbar Buttons" on page 72 for more 
information.

3. Click Apply to save your changes.

The Outbound Dialer toolbar will now appear on the Agent Desktop interface.

Figure 51. Toolbar tab of the User Interface window.

Outbound Dialer Enterprise Data

Whenever an agent receives an Outbound Dialer call, the agent will see Outbound 
Dialer enterprise data. CRS automatically uses the Outbound Dialer enterprise data 
layout (OODefault), which contains all the Outbound Dialer enterprise data variables, 
instead of the regular default layout.
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The Outbound Dialer enterprise data variables are listed in Table 20.

NOTE:  If a call is part of a Direct Preview dialing mode campaign, the 
first letter in the BAStatus field entry is a D when the dialer puts the 
agent in the reserved state, and a C when the agent is connected to a 
customer. If the BAStatus field is blank, all Outbound Dialer buttons 
are disabled. This may be the result of a communication or 
configuration problem.

You can edit the OODefault layout if you want to change which variables are displayed. 
For instructions on editing layouts, see "Layouts" on page 39.

Table 20. Cisco Outbound Dialer enterprise data variables.

Variable Comment

BAAccountNumber [200]

BABuddyName [201]

BACampaign [202]

BADialedListID [203] Required for Preview and Direct Preview dialing 
modes in order for the Skip function to work

BAResponse [204]

BAStatus [205] Required for all dialing modes.

BATimeZone [206] Required for all dialing modes in order for the 
Callback function to work.
112 December 2007



Work Flow Data Fields
Work Flow Data Fields

There are three types of data fields:

■ Standard—Data from the switch.

■ System—System data, for example the date and time. These fields are 
enclosed in square brackets [field name].

■ Enterprise—Data from the Enterprise service. These fields are marked with an 
asterisk (*). 

These fields can be included in the Run Macro and Launch External Application work 
flow actions. 

The available data fields are:

Table 21. Data fields 

Data Field Description

*ANI The number of the phone that made a call.

*Call Variable 1… 
*Call Variable 10

Call-related variable data. There are 10 available 
variables. These custom variables are written into 
CCDRs (call control data records) after the call ends. If 
an agent edits the value during a call, the edited value is 
recorded in the database. These variables are the only 
ones that can be looked up or accessed after a call has 
ended—other ECC variables are lost. 

*Caller Entered Digits Digits entered by the caller in response to IVR 
prompting.

*Customer Account 
Number

The customer’s account number.

*DNIS The number of the phone that received a call.

*Layout The name of the enterprise data layout.

[AGENT_ID] The agent’s identification.

[CALL_DURATION] The difference between the call’s end time and start 
time.

[CALL_END_TIME] The end time of the current call. If the call has not yet 
ended, it is the current time.

[CALL_START_TIME] The start time of the current call. If there is no call, this 
data is empty.

[CLIP_BOARD_TEXT] Any text that is currently in the clipboard.
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[COMPUTER_NAME] The name of the computer the agent is currently logged 
onto.

[USER_NAME] The agent’s login ID.

{LOCAL_PHONE_EXT] The agent’s extension.

Alerting# The number of the ringing phone.

Called# The number of the phone that received a call.

Calling$ The number of the phone that made a call.

Original Called# The original number that received a call.

Original Calling# The original number that made a call.

Table 21. Data fields — Continued

Data Field Description
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Wrap-up Data

Wrap-up data descriptions are used by contact centers for purposes such as tracking 
the frequency of different activities and identifying the account to which to charge a 
call. Wrap-up data is set up and maintained using the Wrap-up Data Editor window 
(see Figure 52). 

Figure 52. Wrap-up Data Editor window.

During a call, the agent selects the Work state. If wrap-up codes are enabled, the 
agent then selects the appropriate wrap-up code to describe the work time for the 
call. When the wrap-up work is completed, the agent selects another state. 

You can configure CRS so that agents in specified contact service queues 
automatically transition to the Work state after a call (Automatic Work option). You 
can also configure how long the Work state lasts (Wrapup Time option). When the 
configured time period is over, the agent is automatically transitioned back to the 
Ready state. See your Customer Response Solutions Administration documentation 
for instructions on how to configure these contact service queue options.

There is no limit on how many wrap-up data descriptions can be set up for Agent 
Desktop. IP Phone Agent has a limit of 100 wrap-up data descriptions.

When creating wrap-up data descriptions, follow these guidelines:

■ Descriptions may consist of up to 39 alphanumeric characters. No 
punctuation or other characters are allowed.

■ Duplicate descriptions are not allowed.
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NOTE:  For Chinese, Japanese, and Korean localized sites, 
descriptions may not appear correctly in IP Phone Agent due to the 
phone limitations on multi-byte characters. 

To enable or disable wrap-up data:

■ Select or clear the Enable wrap-up data check box, and then click Apply.

Wrap-up data is now enabled or disabled. 

To add a new wrap-up data description:

1. In the Description field, type the new wrap-up data description and then click 
Add.

The new description is added to the Wrap-up Data pane.

2. Click Apply to save your changes.

To edit a wrap-up data description:

1. Select the wrap-up data description you want to edit from the Wrap-up Data 
pane.

The description is displayed in the Description field.

2. Edit the description in the Description field, and then click Edit.

The description is changed and appears in the Wrap-up Data pane.

3. Click Apply to save your changes.

To delete a wrap-up data description:

1. Select the wrap-up data description you want to delete from the Wrap-up Data 
pane.

The description is displayed in the Description field.

2. Click Delete.

The description is deleted from the Wrap-up Data pane.

3. Click Apply to save your changes.
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Enterprise Data

The Enterprise Data Setup dialog box enables you to: 

■ Configure Agent Desktop so that agents can edit enterprise data

■ Set thresholds for call duration at a particular type of device while a call is in 
the contact center

Data Tab

The Data tab (Figure 53) controls whether or not the agent is allowed to edit the 
enterprise data displayed in Agent Desktop. Select or clear the check box to 
enable/disable editing.

Figure 53. Data tab.

Call Activity Tab

The Call Activity tab enables you to set the thresholds for call duration at a particular 
type of device (CSQ and Agent) while a call is in the contact center.

If a call remains at a device longer than the defined Caution or Warning threshold, a 
Caution or Warning icon is displayed next to the device name in the Agent Desktop 
call activity pane.
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Figure 54. Call Activity tab. 

To set up call activity thresholds:

1. On the Call Activity tab, enter the threshold times as desired.

Enter values in the Warning fields before entering values in the Caution fields. 
If you enter values in the Caution fields first, Desktop Administrator 
automatically enters values one second greater in the Warning fields.

The Warning threshold value must be greater than the Caution threshold 
value. If you enter a greater value in the Caution field, Desktop Administrator 
automatically changes it so that it is one second less than the Warning value.

Maximum Warning value:59 minutes, 59 seconds 
Maximum Caution value:59 minutes, 58 seconds

2. Click Apply to save your changes.
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Personnel Configuration
Introduction

Personnel Configuration enables you to view information about agents, supervisors, 
and teams within a logical contact center.

Some of the data for agents, supervisors, and teams is configured in CRS and is only 
viewable, not editable, from within Desktop Administrator. 
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Agents

The Agents window (Figure 55) displays a list of all the agents configured in CRS. 

From this window you can change an agent’s work flow group affiliation. You cannot 
change the agent’s user ID, password, display name, or team name—that information 
must be administered through CRS.

Figure 55. The Agents window.

To view agent properties:

1. Select the agent from the agent list, and then click Properties.

The Agent Properties dialog box appears (see Figure 56).

2. Click OK to close the dialog box.

Changing an Agent’s Work Flow Group

An agent can belong to only one work flow group at a time. All agents are assigned to 
the Default work flow group until reassigned to another one.

To change an agent’s work flow group:

1. Select the agent from the agent list, and then click Properties.

The Agent Properties dialog box appears (see Figure 56).
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2. Select a work flow group from the drop-down list, and then click OK.

The agent is now assigned to a new work flow group.

Figure 56. Agent Properties dialog box.

Table 22. Agent Properties dialog box fields

Field Description

ID Agent’s Agent Desktop user ID

Display Name Agent’s name as seen in CAD/CSD

Team Name Team to which the agent is assigned

Work Flow Group Work flow group that controls the agent’s desktop and 
work flow configuration
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Supervisors

The Supervisors window (Figure 57) displays a list of all the supervisors configured in 
CRS. 

From this window you can change a supervisor’s password (it can also be changed 
from within Supervisor Desktop). You cannot change the supervisor’s user ID, display 
name, or team affiliation—that information must be administered through CRS. 

Figure 57. The Supervisors window.

To view supervisor properties:

1. Select the supervisor from the supervisor list, and then click Properties.

The Supervisor Properties dialog box appears (Figure 58).

2. Click OK to close the dialog box.

Changing a Supervisor’s Password

Initially, a supervisor’s password is set to be identical to the supervisor’s user ID by 
the Sync service when the application is installed. The supervisor can then change the 
password to what he or she wants.
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In the event the supervisor forgets the password, you can reset it from the Supervisor 
Properties dialog box. The supervisor can then change that password to one of his or 
her own choosing.

To change a supervisor’s password:

1. Select the supervisor from the supervisor list, and then click Properties.

The Supervisor Properties dialog box appears (see Figure 58).

2. Enter a new password in the Password field (it will appear as asterisks), and 
then click OK.

The password is changed.

Figure 58. The Supervisor Properties dialog box.

Table 23. Supervisor Properties dialog box fields

Field Description

ID The supervisor’s Supervisor Desktop user ID

Password The supervisor’s password.

Display name The supervisor’s name as seen in CAD/CSD

Team/Type pane The team the supervisor is assigned to, and the type 
(primary or secondary) of supervisor
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Teams

The Teams window enables you to view the supervisors, agents, and contact queues 
for a particular team. All this information is administered through CRS. You can only 
view the information in Personnel Configuration.

Supervisors Tab

The Supervisors tab (Figure 59) displays the primary supervisor, secondary 
supervisors, and available supervisors for the team you selected. 

NOTE:  Each team must have a primary supervisor. If there is no 
primary supervisor, secondary supervisors will not see that team in 
the Team List in Supervisor Desktop. Also, if that team is a 
supervisor’s only team, the supervisor won’t be able to log into 
Supervisor Desktop.

Figure 59. Supervisors tab.
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Agents Tab

The Agents tab (Figure 60) displays a list of the agents who belong to the team you 
selected, as well as a list of all available agents. Agents are assigned to teams from 
within CRS.

NOTE:  An agent can belong to only one team in CRS. However, the 
Available Agents pane lists all agents not on the selected team, even 
if they are already assigned to another team.

NOTE:  If you move an agent from one team to another in CRS, you 
must log the agent out of CAD and then log back in for the team 
change to register within Supervisor Desktop.

Figure 60. The Agents tab.

Contact Service Queue Tab

The Contact Service Queue tab (Figure 61) displays a list of the contact service 
queues that route calls to the selected team, as well as a list of all available queues. 
This relationship is set up within CRS.
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Figure 61. The Contact Service Queue tab
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Tutorials
Introduction

This chapter shows you how to perform several common tasks. The tasks are 
presented as tutorials, and each task includes step-by-step instructions, sample 
screens, and keystroke macro examples. 

The tutorials are based on a fictional company called Rock Coast Products. The 
tutorials are:

■ Setting Up an ANI-Based Screen Pop (page 128). Search a Microsoft Outlook 
contact list for the ANI (calling number).

■ Using a Terminal Emulator Package (page 132). Use terminal emulation 
software to find the caller’s name based on the calling number and then 
create an e-mail message using Microsoft Outlook.

■ Setting Up a Task Button to Transfer to a Specified Number (page 137). Set up 
a task button that allows agents to transfer calls to their supervisors.

■ Setting Up a Task Button for After-Call Work (page 138). Set up a task button 
that creates a Microsoft Outlook e-mail message for after-call work.

■ Setting Up a Launch External Application Action (page 147). Set up an action 
that automatically launches a third-party application.

■ Using Wild Card Data Conditions (page 148). Use wild card data conditions 
when setting up rules.

Detailed information about Desktop Administrator’s macro recording capabilities is 
found in the section, Run Macro Action on page 88. 

NOTE:  The macros used in these tutorials might need fine-tuning, 
depending on the PC used and the third-party software accessed.
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Setting Up an ANI-Based Screen Pop

Premise
Rock Coast Products wants to use the ANI (calling number) as the basis for a screen 
pop containing customer contact information.

Procedure
Set up a macro to search for the calling number in a Microsoft Outlook 2000 contact 
list.

NOTE:  This example uses Microsoft Outlook 2000 SR-1(9.0.0.3821). 
If you have a different version, your keystrokes might vary.

1. Open Outlook. 

2. In the Navigation pane of Desktop Administrator, click Desktop Configuration 
> Work Flow Groups > Agents, select a work flow group, and then click Work 
Flow.

The Work Flow Setup window appears (see Figure 32).

3. Select Ringing from the Events list box, and then click New under the Rules 
area.

The New Rule Name dialog box appears (see Figure 33).

4. Enter a name (for example, CustContact), and then click OK.

The Work Flow Setup window appears.

The new rule appears in the Rules list.

5. Select the new rule, and then click Edit next to the first Data Field Conditions 
field.

The Data Field Conditions dialog box appears (see Figure 34).

6. Select Calling# from the Data Field drop-down list, select the Enable Condition 
check box, select the Is Not Empty data field filter, and then click OK.

The Data Field Conditions dialog box closes, and the Work Flow Setup window 
appears.

7. Select the Enable Rule check box, and then click Any Condition is True.

8. Click Add under the Actions area to create a new action for the event.

The Select Action dialog box appears.

9. In the Select Action dialog box, select the Run Macro tab and then click New.

10. In the New Macro dialog box, enter a new macro action name (for example, 
LookUpPhoneNumber) and then click OK.

The Macro Editor dialog box appears (see Figure 37).
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11. In the Macro Editor dialog box, note that the macro name entered in step 5 
appears in the title bar. Click Record.

The Macro Editor dialog box minimizes.

12. Use your mouse to maximize Outlook and begin typing the following macro 
keystrokes; the Macro Recorder records your keystrokes.

13. Click Insert Data. 

The Select a Data Field dialog box appears.

14. Select the CALLING# data field from the list, and then click OK.

The Macro Recording Suspended dialog box appears.

15. Click Resume Recording and enter the remaining macro keystrokes, shown 
below.

16. The macro is now complete. To test it, click Playback.

Macro Keystrokes Action

ALT-V Access the View menu

G Select Go to…

O Select Contacts

ALT-T Access the Tools menu

D Select Advanced Find

ALT-C Moves the cursor to the Search for the 
word(s) field

Press F2 (or whichever key 
has been set up as the 
macro hot key)

Pause macro recording and bring up the 
Macro Recording Suspended dialog box

Macro Keystrokes Action

ALT-I Selects the In field

P Toggles to the Phone number fields only 
option

ALT-N Clicks the Find Now button

Press F2 (or whichever key 
has been set up as the 
macro hot key)

Pause macro recording and bring up the 
Macro Recording Suspended dialog box
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You can make changes to the macro in the edit window, and you can test the 
changes by clicking Playback.

NOTE:  You might see multiple [ALT] entries in the macro. These are 
extraneous and can be deleted. If left in the macro, they will not 
cause errors.

17. Once you are satisfied with the macro, click OK to save it and add it to the list 
of available macros that can be selected as actions.

18. Select the new macro and click OK. 

The Work Flow Setup window appears. Notice that the macro has been added 
to the list of actions for the selected rule and event.

Macro Text
The following text appears in the Macro Editor dialog box:

[APPLICATION:RCTRL_RENWND32=INBOX - MICROSOFT OUTLOOK]
[ALT] V
G
O
[ALT] T
D
[APPLICATION:RCTRL_RENWND32=ADVANCED FIND]
[ALT] C
[DATA FIELD:CALLING#]
[ALT] I
P
[ALT] N

Now you must record a second macro to close the Advanced Find dialog box. Make 
sure to keep Outlook and the Advanced Find dialog box open.

1. In the Work Flow Setup window, select Dropped from the Events list box.

2. Under the Actions list, click New to create a new action.

3. In the Select Action dialog box, select the Run Macro tab and then click New.

4. In the New Macro dialog box, enter a new macro action name (for example, 
CloseAdvFind) and then click OK.

5. In the Macro Editor dialog box, note that the macro name entered in Step 4 
appears in the title bar. Click Record.

The Macro Editor dialog box minimizes.

6. Use your mouse to maximize the Advanced Find dialog box and begin typing 
the following macro keystrokes; the Macro Recorder records your keystrokes.

Macro Keystrokes Action
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NOTE:  You must add a delay at the beginning of the macro. See 
“Macro Text” below.

7. Once you have finished recording the macro, press the macro hot key to bring 
up the Macro Recording Suspended dialog box, and then click End Recording.

8. To test your macro, click Playback.

9. Once you are satisfied with the macro, click OK to save it and add it to the list 
of available macros that can be selected as actions.

10. Select the new macro and click OK.

The Work Flow Setup window appears. Notice that the macro has been added 
to the list of actions for the selected rule and event.

Macro Text
The following text appears in the Macro Editor dialog box:

[DELAY] 1500
[APPLICATION:RCTRL_RENWND32=ADVANCED FIND]
[ALT] F
C

ALT-F Access the File menu

C Close the Advanced Find dialog box

Press F2 (or whichever key 
has been set up as the 
macro hot key)

Pause macro recording and bring up the 
Macro Recording Suspended dialog box
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Using a Terminal Emulator Package

Premise
Rock Coast Products would like to use a terminal emulation program to find the 
caller’s name based on the calling number, and then automatically create an e-mail 
message each time a call is received.

Steps
This example uses the following software:

■ Terminal emulation software—HostExplorer for Windows 95/98, file version 
6.1.0.0. from Hummingbird Communications, Ltd.

■ E-mail program—Microsoft Outlook 98 (8.5.5104.6)

Use two macros since each can potentially be reused with other actions. It is easier to 
create and debug small macros and then run them as two actions in a sequence to do 
larger tasks. 

■ The first macro accesses the terminal emulation program and copies the 
caller’s name to the clipboard.

■ The second macro copies the number from the clipboard and uses it in an 
e-mail message.

NOTE:  Terminal emulation packages can be unpredictable when 
used with macros. The keyboard/terminal emulation must be correct 
for the macros to record and play back correctly. Some terminal 
emulation packages do not have a provision for highlighting and 
copying text from a window.

Make sure both programs are running before recording the macros. Also make sure 
that the terminal program is logged in to a server, and open a text file using Vi (a Unix 
editor). The text file layout is shown below:

Phone Number Name
612-971-2000 Spanlink Communications
612-555-1234 John Smith
612-555-0000 Mary Nelson
612-555-5555 Ned Marvin

Set up the Vi macro:

1. Open Vi, log into the server, and open the text file.

2. Run Desktop Administrator, click Work Flow, and add a new action for the 
Ringing event.

3. In the Select Action dialog box, click New in the Run Macro dialog box.
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4. Enter a new macro action name (for example, GetNamePutInClipBoard) and 
then click OK.

5. In the Macro Editor dialog box, click Record. 

The Macro Editor dialog box minimizes.

6. Maximize Vi, and begin typing the following macro keystrokes; the macro 
recorder records your keystrokes.

7. In the Macro Recorder Suspended dialog box, click Insert Data.

The Select a Data Field dialog box appears.

8. Select the data field you wish to insert from the list, and then click OK.

The Macro Recording Suspended dialog box appears.

9. Click Resume Recording. Begin typing the following keystrokes.

Macro Keystrokes Action

H Place the cursor in the “home” position

/ Search

F2 (or whichever key has 
been set up as the macro 
hot key)

Pause macro recording and bring up the 
Macro Recorder Suspended dialog box

Macro Keystrokes Action

ENTER Search

Positioned on the Phone Number field

/ Search

<SPACE> Search for a space to get to the Name 
column

ENTER Search

Positioned after the Phone Number field

L Move right one character (over the first 
space)

L Move right one character (over the second 
space)
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10. Once you have finished recording the macro, press the macro hot key to bring 
up the Macro Recorder Suspended dialog box, and then click End Recording.

The Macro Editor window appears.

11. To test your macro, click Playback. You can make changes to the macro in the 
Edit window, and you can test the changes by clicking Playback.

12. Once you are satisfied with the macro, click OK to save it and add it to the list 
of available macros that can be selected as actions.

13. Select the new macro and click OK.

The Work Flow Setup window appears. Notice that the macro has been added 
to the list of actions for the selected rule and event.

After you have recorded both macros, notice that both appear in the Work Flow Setup 
window. Make sure that they appear in the order shown in Figure 62.

[SHIFT] [CONTROL] 
[RIGHT-ARROW]

The next three key stroke combinations 
select the caller’s name

[SHIFT] [CONTROL] 
[RIGHT-ARROW]

[SHIFT] [CONTROL] 
[RIGHT-ARROW]

[ALT]-E Vi Edit menu

C Copy the selected text to the clipboard

Press F2 (or whichever key 
has been set up as the 
macro hot key)

Pause macro recording and bring up the 
Macro Recorder Suspended dialog box
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Figure 62. Work Flow Setup window.

Vi Macro Text
The following text appears in the Macro Editor dialog box:

[APPLICATION:HOSTEXPLORER=1 - DEFAULT (DEACON)]
[SHIFT] H
/
[DATA FIELD:CALLING#]
[ENTER]
/
[SPACE]
[ENTER]
L
L
[SHIFT] [CONTROL] [RIGHT-ARROW]
[SHIFT] [CONTROL] [RIGHT-ARROW]
[SHIFT] [CONTROL] [RIGHT-ARROW]
[ALT] E 
C

Outlook Macro Text
The following text appears in the macro recorder dialog box:

[APPLICATION:RCTRL_RENWND32=INBOX - MICROSOFT OUTLOOK]
[SHIFT] [CONTROL] B
[APPLICATION:ABCLS=ADDRESS BOOK]
[ALT] Y 
[CONTROL] V
[CONTROL] N
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[SHIFT] R
E
G
A
R
D
I
N
G
[SPACE]
[SHIFT] Y
O
U
R
[SPACE]
[SHIFT] C
A
L
L
[SPACE]
O
N
[SPACE]
[SYSTEM FIELD:CALL_START_TIME]
[TAB]
[SHIFT] D
E
A
R
[SPACE]
[CONTROL] V
.
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Setting Up a Task Button to Transfer to a 
Specified Number

Premise
Rock Coast Products wants to set up a call control button that will allow agents to 
easily transfer calls to their supervisor.

Steps

1. In Desktop Administrator, click Desktop Configuration > Work Flow Groups > 
Agents and select a work flow group, and then click User Interface.

The User Interface Setup window appears.

2. On the Toolbar tab, select the task button you want to configure.

3. Select the Visible check box.

4. Type a brief hint to describe the action (for instance “Xfer to Super”) in the 
hint field.

5. Click Add.

6. In the Select Action dialog box, select the Call Control tab, and then click New.

7. In the Setup Call Control Action dialog box, enter a name for the action in the 
Action Name field, select the call control type, and then enter the supervisor’s 
telephone number in the Phone Number field.

8. Click OK to save the settings.

9. On the Call Control tab, the new action is highlighted. Click OK.

The User Interface Setup window appears.

10. On the Toolbar tab, the new action is now associated with the task button you 
are configuring.

11. Click OK to save the changes.
December 2007 137



Cisco Desktop Administrator User Guide 
Setting Up a Task Button for After-Call Work

Premise
Rock Coast Products wants to set up a task button that prepares a Microsoft Outlook 
2000 e-mail message for after-call work.

This example retrieves customer information (e-mail address, name, and amount of 
sale) from an Access 2000 database and pastes that information into an Outlook 
2000 e-mail message. 

Assumptions

■ The agent has been looking at the customer’s record in the Access database 
in form view

■ Outlook is open on the agent’s desktop and is displaying the In Box.

■ The agent reviews the automatically-generated e-mail and sends it manually.

Steps

1. In Desktop Administrator, click Desktop Configuration > Work Flow Groups > 
Agents, select a work flow group, and then click User Interface.

The User Interface Setup window appears.

2. On the Toolbar tab, select the task button you wish to configure.

3. Select the Visible check box.

4. Type a brief hint to describe the action (for instance “After Call Email”) in the 
hint field.

5. Click Add.

6. In the Select Action dialog box, select the Run Macro tab and then click New.

The New Macro dialog box appears.

7. In the New Macro dialog box, type a name for the new macro (for instance, 
“AfterCallEmail”), and then click OK.

The Macro Editor window appears.

8. Click Record to start recording the macro.

9. Use your mouse to maximize Access, and then begin typing the following 
macro keystrokes; the macro recorder records your keystrokes.

Macro Keystrokes Action

[HOME] Press Home to position the cursor in the 
first field in the form.
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10. Use your mouse to maximize Outlook, and then type the following macro 
keystrokes.

[TAB] Press the tab as many times as needed to 
go to the e-mail address field.

[CONTROL] C Copy the e-mail address.

[HOME] Press Home to position the cursor in the 
first field in the form.

[CONTROL] N Open a blank e-mail message.

[CONTROL] V Paste the e-mail address in the To: field in 
the e-mail message.

[TAB] Tab down to the Subject line.

[TAB]

[SHIFT] Y Type “Your Order” in the Subject line.

O

U

R

[SPACE]

[SHIFT] O

R

D

E

R

[TAB] Tab to the body of the message.

[SHIFT] D Type the salutation “Dear ”

E

A

R

[SPACE]
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11. Use your mouse to maximize Access, and then type the following macro 
keystrokes.

12. Use your mouse to maximize Outlook, and then type the following macro 
keystrokes.

[TAB] Tab as many times as needed to get to the 
Name field.

[CONTROL] C Copy the customer’s name.

[CONTROL] V Paste the customer’s name after the 
salutation.

[ENTER] Press the Return key twice to start a new 
line for the body of the message.

[ENTER]

[SHIFT] T Type the message: “Thank you for your 
order in the amount of ”.

H

A

N

K

[SPACE]

Y

O

U

[SPACE]
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F

O

R

[SPACE]

Y

O

U

R

[SPACE]

O

R

D

E

R

[SPACE]

I

N

[SPACE]

T

H

E

[SPACE]

A

M

O

U
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13. Use your mouse to maximize Outlook, and then type the following macro 
keystrokes.

N

T

[SPACE]

O

F

[SPACE]

[TAB] Tab as many times as needed to get to the 
Amount of Sale field.

[CONTROL] C Copy the amount of sale.

[CONTROL] V Paste the amount of sale in the body of the 
message.

. Add a period to the sentence.

[SPACE] Type “Your order is in the mail.” to finish 
the e-mail message.

[SHIFT] Y

O

U

R

[SPACE]

O

R

D

E

R

[SPACE]
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14. Once you have finished recording the macro, press the macro hot key to 
display the Macro Recording Suspended dialog box, and then click End 
Recording.

15. To test your macro, click Playback. You can make changes to the macro in the 
Macro Editor window and then test them by clicking Playback again.

TIP: To slow down the macro so you can watch the steps, insert the command 
[DELAY] 1000 before and after the commands for maximizing Outlook and 
Access. This will help you debug the macro. For instance:

[DELAY] 1000 
[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : FORM]
[DELAY]1000

16. Once you are satisfied with the macro, click OK to save it and add it to the list 
of available macros that can be selected as actions.

17. On the Run Macros tab, the new macro is highlighted. Click OK to return to the 
User Interface Setup window.

18. In the User Interface Setup window’s Toolbar tab, the new macro action is now 
associated with the task button you are configuring.

19. Click OK to save the changes.

I

S

[SPACE]

I

N

[SPACE]

T

H

E

[SPACE]

M

A

I

L

.
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Sample Macro Text
The following text appears in the macro recorder dialog box:

[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : FORM]
[HOME]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[CONTROL] C
[APPLICATION:RCTRL_RENWND32=INBOX - MICROSOFT OUTLOOK]
[CONTROL] N
[APPLICATION:RCTRL_RENWND32=UNTITLED - MESSAGE (PLAIN 
TEXT) ]
[CONTROL] V
[TAB]
[TAB]
[SHIFT] Y
O
U
R
[SPACE]
[SHIFT] O
R
D
E
R
[TAB]
[SHIFT] D
E
A
R
[SPACE]
[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : FORM]
[HOME]
[TAB]
[CONTROL] C
[APPLICATION:RCTRL_RENWND32=YOUR ORDER - MESSAGE (PLAIN 
TEXT) ]
[CONTROL] V
,
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[ENTER]
[ENTER]
[SHIFT] T
H
A
N
K
[SPACE]
Y
O
U
[SPACE]
F
O
R
[SPACE]
Y
O
U
R
[SPACE]
O
R
D
E
R
[SPACE]
I
N
[SPACE]
T
H
E
[SPACE]
A
M
I
[BACKSPACE]
O
U
N
T
[SPACE]
O
F
[SPACE]
[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : FORM]
[TAB]
[TAB]
[TAB]
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[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[CONTROL] C
[APPLICATION:RCTRL_RENWND32=YOUR ORDER - MESSAGE (PLAIN 
TEXT) ]
[CONTROL] V
.
[SPACE]
[SHIFT] Y
O
U
R
[SPACE]
O
R
D
E
R
[SPACE]
I
S
[SPACE]
I
N
[SPACE]
T
H
E
[SPACE]
M
A
I
L
.
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Setting Up a Launch External Application 
Action

Premise
Rock Coast Products wants to set up a task button that automatically launches a 
third-party application.

Steps
In this example you set up an action that launches Microsoft WordPad and then 
associates the action with a task button on the agent’s toolbar.

1. In Desktop Administrator, click Desktop Configuration > Work Flow Groups > 
Agents, select a work flow group, and then click User Interface.

The User Interface Setup window appears.

2. On the Toolbar tab, select the task button you want to configure.

3. Select the Visible check box.

4. Type a brief hint to describe the action (for instance, “WordPad”) in the hint 
field.

5. Click Add.

6. In the Select Action dialog box, select the Launch External Application tab, 
and then click New.

7. In the Setup Launching External Application Action dialog box, enter a name 
for the action in the Action Name field and browse to the application’s 
executable (Wordpad.exe) in the Application field.

Remember that the application should be located on a network drive so it is 
accessible to all agents. If you must use an application located on the agent’s 
PC, make sure that the application is accessible by an identical path on each 
agent’s PC.

8. If you want, add any of the available arguments to pass to WordPad. Select 
the arguments from the right Available Arguments pane and use the left and 
right arrows to add or remove them to the left Arguments pane. Use the up 
and down arrows to rearrange the order in which they will appear.

9. Click OK to return to the Launch External Application tab with the new action 
highlighted in the list of actions. 

10. Click OK to return to the User Interface Setup window.

11. In the User Interface Setup window’s Toolbar tab, the new action is now 
associated with the task button you are configuring.

12. Click OK to save the changes.
December 2007 147



Cisco Desktop Administrator User Guide 
Using Wild Card Data Conditions

Premise
Rock Coast Products is located in a city with two neighboring area codes. The east 
metro area code is 651 and the west metro area code is 612. Rock Coast’s Customer 
Service Division has one agent who assists east metro callers and one agent who 
assists west metro callers.

If an east metro caller dials the main Customer Service number, Rock Coast wants 
that call directed automatically to the agent who handles east metro calls.

To separate east metro callers, Rock Coast sets up rules using the data conditions Is 
in the List and Is not in the List. These data conditions return as true only if there is an 
exact string match. 

Entering hundreds or even thousands of telephone numbers into a list is not feasible, 
so Rock Coast uses wild card data conditions. This operation is similar to the function 
of the Find tool in Windows. You can enter part of a string or a whole string to find 
what you’re looking for. See "Wild Card Searches" on page 85 for more information on 
using wild cards.

Procedure
Set up a wild card data condition that will transfer calls from the 651 area code to the 
east metro agent:

1. In Desktop Administrator, click Desktop Configuration > Work Flow Groups > 
Agents, select a work flow group, and then click Work Flow.

The Work Flow Setup window appears.

2. Select the Ringing event.

3. Under the Rules pane, click New.

4. Create a new rule named East Metro.

5. In the Work Flow Setup window, note that the new rule appears in the Rules 
list. With the new rule highlighted, click Edit next to the first Data Field 
Conditions field.

6. Select Calling# from the Data Field drop-down list.

7. Check Enable Condition.

8. Check Is in the list.

9. Add the wild card data condition 651* to the list.

10. Click OK.

11. Select Enable Rule.

12. Click OK.
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Glossary
ACD See automatic call distribution.

action An occurrence that takes place when a rule is met. More than one 
action can take place as a result of meeting a rule.

administrator The person who administers Cisco Agent Desktop. The administrator 
defines work flows and teams, and the look and feel of the agent’s 
desktop.

agent The person who interacts with customers in a contact center. 

Agent Desktop The Cisco desktop application used by a contact center agent to 
handle customer calls.

agent state An agent’s current ACD status. Possible statuses are Ready, Not 
Ready, Work, Reserved, Hold, Talking, and Logged Out.

Agent State action An action type that changes an agent’s ACD agent state.

Always on Top mode A display mode in which the interface is always on top of all other 
windows and does not minimize.

Always Open mode A display mode in which the interface is always visible, but may be 
hidden by other open applications.

ANI See automatic number identification. 

area code A 3-digit code designating a toll center in the United States and 
Canada.

array variable An ICM extended call context (ECC) variable that stores multiple 
pieces of data.
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automatic call 
distributor (ACD)

Optional software that resides on the PBX. Its role is to monitor 
various parameters within the system and call center and to 
intelligently route calls based on that information. 

automatic number 
identification (ANI)

A series of digits at the front of a phone call that delivers the billing 
number (which is not necessarily the phone number) of the caller.

barge-in A feature in Supervisor Desktop that allows a supervisor to forcibly 
join an agent’s call with a customer. It is a forced conference call.

bridged appearance A situation in which two devices share the same phone number (for 
example, a secretary whose phone can also answer the boss’s 
phone). 

call activity data The information displayed Agent Desktop documenting the length of 
time a call is at a particular type of device or agent within the call 
center. 

call center A location where calls are made and answered. A call center typically 
has numerous agents and an automatic call distributor. 

call control The action of changing the state of a call, for instance, making, 
answering, transferring, or dropping a call.

Call Control action An action that performs a call control function triggered by an event 
meeting a rule. Call control actions vary according to switch type.

call history See call activity data.

call log The record of calls made and received by a desktop while running 
Agent Desktop.

call routing The automatic sending of calls to the desired destination, such as an 
extension or a queue.

caller input Touchtone data entered by the caller in response to prompting.

CallManager A Cisco software-based voice-over IP telephone switch.

Chat A feature of Agent Desktop and Supervisor Desktop that enables 
agents and supervisors to communicate via an instant messaging 
window.

Chat service A service that acts as a message broker between the Chat clients and 
Supervisor Desktop. It is in constant communication with all agents 
and supervisor desktops. 
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chat session A written exchange between agents or between agent and supervisor 
using the Chat application.

Cisco Unified Contact 
Center Express

Cisco Unified Contact Center Express serves as an IP-based 
automated call distribution (ACD) system. It queues and distributes 
incoming calls that are destined for groups of Cisco CallManager 
users.

Cisco Unified Outbound 
Dialer

The Cisco Unified Outbound Dialer product (Unified OUTD), formerly 
Outbound Option and Blended Agent, allows Unified CCE agents to 
participate in outbound calling campaigns in addition to handling 
inbound calls. Unified OUTD is available in the Enhanced and 
Premium bundles of CAD.

Computer telephony 
integration (CTI)

The connection of a computer with a telephone switch that allows the 
computer to issue commands and receive event information for calls 
and agents. 

configuration file The computer file that stores the settings for an application.

contact center An expansion of a call center, so that it can make and receive not only 
phone calls, but email, faxes, web chat messages, and so on.

contact service queue In Cisco Unified Contact Center Express, a CSQ is a call queue 
associated with a single Cisco CallManager CTI route point.

CORBA Common Object Request Broker Architecture. An architecture and 
specification for creating, distributing, and managing distributed 
program objects in a network. It allows programs at different 
locations and developed by different vendors to communicate in a 
network through an interface broker.

country code The 1–3 digit code that, in the world numbering plan, identifies each 
country or integrated numbering plan in the world.

CRS See Customer Response Solution.

CSQ See contact service queue.

CTI See computer telephony integration.

CTI route point A virtual device that can receive multiple simultaneous calls for the 
purpose of application-controlled redirection.

data field A piece of information about a phone call that is available for display 
in the Agent Desktop interface. 
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data field condition A logical statement about call data that evaluates as either true or 
false.

data router In networks, a device that connects any number of IP local area 
networks (LANs).

data switch In networks, a device that filters and forwards packets between LAN 
segments.

database A collection of data structured and organized in a disciplined fashion 
so that information of interest can be accessed quickly.

deflected call A ringing call that is redirected to another extension without being 
answered first.

delimiter A word or character that marks the beginning or end of a segment of 
data.

Desktop Administrator The application used to administer Cisco Agent Desktop.

device A unit (for example, a telephone) connected to the telephone system. 

Dial Pad The soft phone screen that enables an agent to dial a number.

dial plan A description of the dialing arrangements for customer use on a 
telephone network. For example, the local access code, local area 
code, etc.

dialed number 
information service 

(DNIS)

A telephony network feature that provides the number the caller 
dialed.

Directory Services The service that all other CAD services register with at startup. Clients 
use this service to request information about other CAD components. 
Also known as LDAP.

DNIS See dialed number information service.

drop To hang up or disconnect a phone call.

Dropped event An event which indicates a call is disconnected.

DTMF See Dual Tone Multi-Frequency.

dual tone 
multi-frequency (DTMF)

The term for touchtone dialing. In DTMF, when you touch a button on 
a push button pad, it makes a tone which is actually a combination of 
two tones, one high frequency and one low frequency. These are the 
beeps you hear when you dial a phone number.
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duplex environment An operating environment that contains a primary and secondary 
service. If the primary service fails, the secondary service takes over.

ECC variable See expanded call context variable.

enterprise data A piece of data available to CAD via the Enterprise service.

Enterprise service A server program that tracks calls in the system. It is used to attach 
IVR-collected data to a call in order to make real-time call activity data 
available at the agent desktop.

Ethernet A local area network standard. Like other LAN technologies, Ethernet 
is used to connect computers, printers, workstations, terminals, 
servers, and other devices within the same building or campus.

event An occurrence at the agent desktop. Events include: startup, 
shutdown, ringing, answered, and dropped. 

expanded call context 
variable

An ICM term for a piece of information about a phone call. It must be 
defined within ICM.

extension The internal telephone number at the agent desktop.

external application A software application not belonging to CAD.

host A server connected to a network.

ICM See Intelligent Contact Management.

Install Manager The program that helps you install CAD on your system.

Intelligent Contact 
Management (ICM)

A Cisco computer telephony integration application that collects data 
and profiles customers from the network to the agent’s desktop, and 
coordinates the delivery of voice and data to a targeted answering 
resource across the enterprise. Using network-provided data, 
caller-entered digits, and information obtained from a customer 
profile database, ICM determines who is calling and why, and routes 
the call to the appropriate area in the contact center.

interactive voice 
response (IVR)

The use of a computer to interact verbally via a telephone with a 
caller. The computer plays announcements and questions to the 
caller, and the caller replies by entering information via touch tones, 
a rotary dial, or by speaking. “IVR” and “VRU” are often used 
interchangeably. See voice response unit (VRU).

intercept An intercept occurs when a supervisor uses the Intercept button to 
force a transfer from an agent to the supervisor. 
December 2007 153



Cisco Desktop Administrator User Guide
Internet protocol (IP) This protocol specifies the format of packets, also called datagrams, 
and the addressing scheme. Most networks combine IP with a 
higher-level protocol called transport control protocol (TCP), which 
establishes a virtual connection between a destination and a source.

IP by itself is something like the postal system. It allows you to 
address a package and drop it in the system, but there’s no direct link 
between you and the recipient. TCP/IP, on the other hand, 
establishes a connection between two hosts so that they can send 
messages back and forth for a period of time.

IP See Internet protocol.

IP address The Internet protocol address of a device. 

IP IVR Cisco Unified IP IVR is an IP-powered interactive voice response 
application that provides an open and extensible foundation for the 
creation and delivery of IVR solutions via Internet technology. It 
automates the handling of calls by autonomously interacting with 
users. 

IP phone A phone that enables you to move multimedia traffic over any 
network that uses Internet protocol (IP).

IP Phone Agent service The service that enables IP phone agents to log in and out of ICM, 
change agent states, and enter wrap-up data and reason codes 
without having the Agent Desktop software. This service works in 
conjunction with the Services feature of CallManager and model 
7940/7960 Cisco IP phones.

IP port In TCP/IP and UDP networks, an endpoint to a logical connection.

IPCC See IP Contact Center.

IVR See interactive voice response.

LAN See local area network.

Launch External 
Application action

An action that starts an external application from within Agent 
Desktop. 

LCC See logical contact center.

LDAP See lightweight directory access protocol.

LDAP Monitor service The service that starts Directory Services and then monitors it to 
ensure that it keeps running.
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LDAP service The service that all other CAD services register with at startup. Clients 
use this service to request information about other CAD components.

License Administration The application used to update the number of seats purchased in 
your CAD system.

Licensing and Resource 
Manager service

The service that distributes licenses to clients and oversees the 
health of the CAD services. In the event of a service failure, it initiates 
the failover process.

lightweight directory 
access protocol (LDAP)

LDAP defines a standard manner of organizing directory hierarchies 
and a standard interface for clients to access directory servers. 

local area network (LAN) Two or more computers, and other devices, connected by cable, 
generally within the same building or campus.

local extension See extension.

logical contact center 
(LCC)

The root of the LDAP tree where CAD applications query for 
information. It is used to segregate logically separate call centers 
within the LDAP server.

macro A series of prerecorded commands that accomplish a task. 

macro hot key In Desktop Administrator, the key used to pause the recording of a 
macro and to display the macro recording menu.

macro recorder The feature in Desktop Administrator used to record a macro.

Normal mode A display mode in which the interface appears when calls are present 
and minimizes when idle.

pane Section of an application window.

password A series of alphanumeric characters required to log onto an 
application or server.

PBX See private branch exchange.

peripheral ID The number within the ICM schema that identifies the peripheral 
device, for example, the peripheral interface managers (PIMs) for 
VRU/IVR, ACD, or CallManager.

phone book In Agent Desktop, any one of the stored phone directories. Agent 
Desktop contains global phone books as well as an employee phone 
book.

PIM See protocol independent multicast.
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plain old telephone 
service (POTS)

The basic service supplying standard telephones, telephone lines, 
and access to the public switched network. 

port See IP port.

POTS See plain old telephone service. 

primary server In a duplex environment, the main server used. If the primary server 
fails, the secondary server takes over.

private branch 
exchange (PBX)

A private telephone network used within an enterprise. Users of the 
PBX share a certain number of outside lines for making telephone 
calls external to the PBX. 

protocol independent 
multicast (PIM)

Multicast routing architecture that allows the addition of IP multicast 
routing on existing IP networks. 

PSTN See public switched telephone network. 

public network A network operated by common carriers or telecommunications 
administrations for the provision of circuit switched, packet switched, 
and leased-line circuits to the public.

public switched 
telephone network 

(PSTN)

Refers to the world’s collection of interconnected voice-oriented 
public telephone networks, both commercial and government-owned.

real-time transport 
protocol (RTP)

An Internet protocol for transmitting real-time data such as audio and 
video.

recent call list A list of an agent’s 100 most recently made phone calls, 
automatically kept in the Dial Pad window. 

Recording & Playback 
service

The service that extends the capabilities of the VoIP Monitor service 
by allowing supervisors and agents to record and play back calls.

Recording & Statistics 
service

A service that maintains a 7-day history of agent and team statistics. 
It also manages call recording.

Ringing event The event that occurs when the phone rings. See Event.

RTP See real-time transport protocol. 

rule A set of 1–3 data field conditions. If any or all the conditions that 
constitute the rule are evaluated as true, then the rule is met. Rules 
that are met trigger events and actions.

Run Macro action An action that starts and runs a macro.
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scalar variable An extended call context (ECC) variable that stores a single piece of 
data.

screen pop The delivery of caller-specific information onto the agent’s computer 
screen (“populating” the screen).

seat An instance of Agent Desktop, Supervisor Desktop, or other CAD 
applications. 

secondary server In a duplex environment, the backup server. If the primary server 
fails, the secondary server takes over. 

shortcut key A keyboard key or key combination (also known as a “hotkey” or 
“keyboard accelerator key”) that invokes a particular command that 
is generally faster to use than clicking the mouse through a menu. 

Shutdown event The event that occurs when Agent Desktop shuts down. See event.

skill An ability (expertise in a particular type of software, fluency in a 
foreign language, for example) of a contact center agent. Calls can be 
routed based on agent skills (skill-based routing) for better customer 
service. 

soft phone A software phone, such as Agent Desktop’s dial pad. 

Startup event The event that occurs when Agent Desktop starts up. See event. 

status bar The area on the Agent Desktop or Supervisor Desktop interface that 
displays the status of the agent and of the CAD system.

Stealth mode A display mode in which an application appears as an icon in the 
system tray unless maximized by the agent.

supervisor The leader and/or manager of a team of agents.

Supervisor Desktop The application used by contact center supervisors to manage agent 
teams in real time.

Sync service The service that connects to the ICM logger SQL database via and 
ODBC connection and retrieves agent, supervisor, team, and skill 
information. It then compares the information with the information in 
Directory SErvices and adds, updates, or deletes entries as needed to 
stay consistent with the ICM configuration.

task button One of a series of up to 10 buttons on the Agent Desktop interface to 
which actions can be assigned. 

team A group of agents who report to the same supervisor.
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Team Performance 
Message (TPM)

A message the supervisor can create to display in Agent Desktop for a 
set length of time to communicate important information. The TPM 
can be scrolling or non-scrolling, depending on how the supervisor 
configures it.

threshold The acceptable amount of time a call can remain at a particular 
device or call center. Caution or warning icons are displayed in the 
Enterprise Data window when thresholds are met or exceeded for a 
call. 

touch tones See dual tone multi-frequency. 

TPM See Team Performance Message.

transfer A phone switch feature that allows moving a call from one extension 
to another.

transfer, blind A transfer in which the active call is transferred to the third party 
without ensuring that the transfer is successful (picked up at the 
other end).

transfer, supervised A transfer in which you speak to the third party to whom the call is 
being transferred before connecting the active call, in order to 
confirm that the transfer can be made successfully.

Unified Contact Center 
Express (Unified CCX)

A Cisco solution for an IP contact center. Its components include 
Cisco Unified IP IVR, Cisco Unified CallManager, and Customer 
Response Solution (CRS).

user ID An identifier that designates a particular user and that is required to 
log into an application or server.

user interface An application’s look and feel to the user. 

virtual private network 
(VPN)

A network created by renting or acquiring some part of someone 
else’s network (a phone company, an Internet provider) and used to 
communicate between a company’s offices.

voice gateway router A combination of hardware and software that links a POTS telephone 
network to an IP data network. 

voice monitoring The ability of a supervisor to monitor an agent’s phone conversations 
without being heard and without letting the agent knowing it is 
happening.

voice packet A digitized sample of a voice conversation sent over a network.
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voice response unit 
(VRU)

The computer used to interact verbally via a telephone with a caller. 
The computer plays announcements and questions to the caller, and 
the caller replies by entering information via touch tones, a rotary 
dial, or by speaking. “VRU” and “IVR” are often used interchangeably. 
See interactive voice response (IVR).

voice-over IP (VoIP) A category of hardware and software that enables people to use 
Internet protocol as the transmission medium for telephone calls.

Voice-over IP Monitor 
service

A service that enables supervisors to silently monitor agents. The 
service accomplishes this by “sniffing” network traffic for voice 
packets.

VoIP See Voice-over IP.

VPN See virtual private network.

VRU See voice response unit.

wild card Special characters used to represent one or more characters in a 
string. An asterisk (*) represents several characters and a question 
mark (?) represents a single character.

work flow A sequence of actions that takes place when specific event/rule 
criteria are met. 

work flow group A group that shares a common set of work flows. 

wrap-up data Wrap-up data descriptions are used by contact centers for purposes 
such as tracking the frequency of different activities and identifying 
the account to which to charge a call. If enabled, an agent is 
prompted to enter a wrap-up data code whenever transitioning to the 
Work state to describe the work being done.
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